APECS® 4500 Electronic Engine Speed Governing System

User Manual
WARNING
Read this entire manual and all other publications pertaining to the work to be performed before installing, operating, or servicing this equipment. Practice all plant and safety instructions and precautions. Failure to follow instructions can cause personal injury and/or property damage.

The engine, turbine, or other type of prime mover should be equipped with an overspeed shutdown device to protect against runaway or damage to the prime mover with possible personal injury, loss of life, or property damage.

The overspeed shutdown device must be totally independent of the prime mover control system. An overtemperature or overpressure shutdown device may also be needed for safety, as appropriate.

CAUTION
To prevent damage to a control system that uses an alternator or battery-charging device, make sure the charging device is turned off before disconnecting the battery from the system.

Electronic controls contain static-sensitive parts. Observe the following precautions to prevent damage to these parts.
- Discharge body static before handling the control (with power to the control turned off, contact a grounded surface and maintain contact while handling the control).
- Avoid all plastic, vinyl, and Styrofoam (except antistatic versions) around printed circuit boards.
- Do not touch the components or conductors on a printed circuit board with your hands or with conductive devices.

IMPORTANT DEFINITIONS
WARNING—indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury.

CAUTION—indicates a potentially hazardous situation which, if not avoided, could result in damage to equipment.

NOTE—provides other helpful information that does not fall under the warning or caution categories.
CHAPTER 6. SERVICE OPTIONS ................................................................. 71
Product Service Options ............................................................................. 71
  Replacement/Exchange ............................................................................. 71
  Flat Rate Repair ..................................................................................... 72
  Flat Rate Remanufacture ........................................................................ 72
Returning Equipment for Repair ................................................................. 72
  Packing a Control ................................................................................... 72
  Return Authorization Number ................................................................. 73
Replacement Parts ....................................................................................... 73
How to Contact Woodward ......................................................................... 73
Engineering Services ................................................................................. 74
Technical Assistance .................................................................................. 75
Electrostatic Discharge Awareness

All electronic equipment is static-sensitive, some components more than others. To protect these components from static damage, you must take special precautions to minimize or eliminate electrostatic discharges.

Follow these precautions when working with or near the control.

1. Before doing maintenance on the electronic control, discharge the static electricity on your body to ground by touching and holding a grounded metal object (pipes, cabinets, equipment, etc.).

2. Avoid the build-up of static electricity on your body by not wearing clothing made of synthetic materials. Wear cotton or cotton-blend materials as much as possible because these do not store static electric charges as much as synthetics.

3. Keep plastic, vinyl, and Styrofoam materials (such as plastic or Styrofoam cups, cup holders, cigarette packages, cellophane wrappers, vinyl books or folders, plastic bottles, and plastic ash trays) away from the control, the modules, and the work area as much as possible.

4. Do not remove the printed circuit board (PCB) from the housing unless absolutely necessary. If you must remove the PCB from the housing, follow these precautions:
   - Do not touch any part of the PCB except the edges.
   - Do not touch the electrical conductors, the connectors, or the components with conductive devices or with your hands.
   - When replacing a PCB, keep the new PCB in the plastic antistatic protective bag it comes in until you are ready to install it. Immediately after removing the old PCB from the control cabinet, place it in the antistatic protective bag.

CAUTION
To prevent damage to electronic components caused by improper handling, read and observe the precautions in Woodward manual 82715, *Guide for Handling and Protection of Electronic Controls, Printed Circuit Boards, and Modules.*
Chapter 1.
General Information

System Basics

APECS is an acronym for Advanced Proportional Engine Control System. It provides a means of controlling engine speed by adjusting the fuel control lever with an actuator. The heart of the system is a powerful microprocessor-based controller that processes the signal received from a speed sensor and compares it to the desired speed setting.

The output of the controller is a pulse-width modulated signal that drives a precision proportional actuator connected to the engine’s fuel control lever. The actuator converts the signal to an output shaft position, proportional to the duty cycle of the pulse-width modulated signal.

The APECS system provides isochronous engine governing (i.e., engine speed is maintained at the commanded setting, regardless of load) through a wide speed range. APECS is suitable for use on both compression ignition (diesel) and spark ignition (gasoline, CNG, LPG) engines.

Woodward developed the APECS system for a variety of on- and off-highway applications. Typical applications include generator sets, compressors, construction machinery and farm vehicles.

WARNING
An overspeed shutdown device, independent of the APECS system, should be provided to prevent loss of engine control that may cause personal injury or equipment damage.

Figure 1. APECS Engine Control System
System Components

The five main components of the system are the APECS controller, all-purpose calibration tool (ACT), speed sensor, actuator, and linkage. In addition to the main components, and depending on the features selected, there are several subcomponents (such as speed switches and potentiometers). Each component contributes to the overall performance of the system and shortcomings in any of the components will detract from total system performance.

APECS Controller

The APECS 4500 series controller is an electronic engine governor that provides a means of controlling and limiting engine speed by adjusting the fuel control lever with a proportional actuator. The APECS controller may be programmed to operate at up to four different speeds. It also operates in either isochronous or droop mode, where droop is user selectable up to 15%.

The controller is software programmable and has no manual adjustments. A calibration tool (ACT) is used for programming (configuring and adjusting) the APECS 4500 controller.

All-Purpose Calibration Tool (ACT)

ACT is a PC (personal computer) based software calibration and monitoring tool. ACT is designed specifically for use with engines equipped with the APECS 4500 controller. The tool can be run on any IBM compatible computer that meets the requirements listed in “ACT Installation” in Chapter 3.

Once the APECS 4500 controller has been programmed, ACT may be disconnected. The APECS 4500 unit will continue to operate normally with ACT either connected or disconnected.

Speed Sensor

APECS 4500 monitors engine speed continuously. Engine speed may be sensed by monitoring the frequency of spark events in spark-ignition engines or through the use of a sensor that detects the passing of teeth on an engine driven gear (e.g., flywheel).

The universal speed input of the APECS 4500 is compatible with the following types of speed input signal:

- **Magnetic Pickup.** Magnetic pickups are available from Woodward
- **Coil-type Spark Ignition.** Speed can be sensed from the negative side of the coil primary winding.
- **Magneto Spark Ignition.** Speed can be sensed from the spark kill wire on the primary winding, but will not work if a diode is placed between the magneto and the APECS input (may be found on some multi-cylinder engines with magneto ignitions.
- **Hall-Effect Sensor**
Actuator

The actuator converts a pulse-width modulated signal received from the controller to an output shaft position proportional to the duty cycle of the pulse-width modulated signal.

The actuator is mounted on the engine and connected to the control lever by a mechanical linkage.

NOTE: On spark ignition engines, the control lever is usually the throttle lever. On compression ignition engines (diesels), the control lever is usually one of the mechanical governor levers (either shutoff or governor).

Linkage

The linkage connects the actuator shaft to the engine control lever. A good linkage allows for misalignments and contributes to accurate, stable and responsive performance with minimal play or friction.

NOTE

The scope of this manual does not include selection and installation of speed sensors, actuators, or linkages that Woodward offers for use with the APECS system. Information is available on our website at www.woodward.com.

NOTE

The need for sub-components such as switches and potentiometers is application dependent. Please contact Woodward for information specific to your application.
Programmable Features

The APECS 4500 expands Woodward’s line of programmable engine governors to address the needs of the mobile equipment industry. Enhanced input and output capability, combined with a flexible configuration, permits the controller to easily adapt to a wide variety of engine governing applications.

Following is a list of features available with the APECS 4500.

- **Analog Speed Setpoint Input**: suitable for use with a potentiometer or an accelerator pedal position sensor (idle verification available)
- **Actuator Current Protection**: protects actuator from burning out
- **Autocrank**: useful for remote operation of engines using an auxiliary output.
- **Auxiliary Outputs**: two outputs which can be configured to drive lamps or relays
- **Droop Governing**: allows non-isochronous speed governing
- **Engine Protection Input**: protects against adverse conditions such as loss of engine oil pressure or excessive coolant temperature
- **Engine Start Calibration**: useful for applications that require special startup operation (e.g. warm-up speed, reduced governor gains, missing speed signal)
- **Glowplug Control**: useful for enhancing cold start capability of a diesel engine using an auxiliary output
- **Historic Fault Codes**: retains a record of past fault codes, even after loss of battery power.
- **Overspeed / Underspeed Protection**
- **PID Gain Adjustment**: allows governor response to be adjusted by user
- **PTO Switch Input**: allows selection between analog speed setpoint input and switched speed setpoint inputs in mobile applications
- **Switched Speed Setpoint Inputs**: allow multiple speed settings using switches. This feature can be configured together with the analog input (speed pot) for a variety of speed select options.
- **Universal Speed Input**: speed input is compatible with most common means for sensing engine speed including mag pickup, ignition and Hall-Effect

To incorporate any of the above features in your system, refer to the Features Table below to determine if additional hardware installation or software configuration is required.
**Features Table**

All features available with the APECS 4500 can be easily installed and configured to work with your application. Refer to the table below to determine if additional hardware installation is required. Software setup is always required to properly configure the feature.

Hardware required for the features is customer supplied and is not sold or supplied by Woodward.

<table>
<thead>
<tr>
<th>FEATURE</th>
<th>ADDITIONAL HARDWARE REQUIRED?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actuator Current Protection</td>
<td>No</td>
</tr>
<tr>
<td>Autocrank</td>
<td>Yes</td>
</tr>
<tr>
<td>Auxiliary Output</td>
<td>Yes</td>
</tr>
<tr>
<td>Droop Governing</td>
<td>No</td>
</tr>
<tr>
<td>Engine Protection Input</td>
<td>Yes</td>
</tr>
<tr>
<td>Engine Start Calibration</td>
<td>No</td>
</tr>
<tr>
<td>Glowplug Control</td>
<td>Yes</td>
</tr>
<tr>
<td>Overspeed / Underspeed Protection</td>
<td>No</td>
</tr>
<tr>
<td>PID Gains Adjustment</td>
<td>No</td>
</tr>
<tr>
<td>PTO Switch Input</td>
<td>Yes</td>
</tr>
<tr>
<td>Analog Speed Setpoint Input**</td>
<td>Yes</td>
</tr>
<tr>
<td>Switched Speed Setpoint Inputs**</td>
<td>Yes</td>
</tr>
</tbody>
</table>

** See Engine Speed Select Options table below

To incorporate any of these features in your system refer to “Installing the Hardware section to install the selected feature and “Calibrating APECS Features” chapter to configure the feature for your application.
Engine Speed Select Options Table

The following speed select options are available with the APECS 4500.

<table>
<thead>
<tr>
<th>SPEED SELECT OPTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NO ANALOG INPUT</strong></td>
</tr>
<tr>
<td>Use a speed switch to select up to 4 discrete speeds or use a momentary switch to manually increase or decrease speed at preset rates.</td>
</tr>
<tr>
<td>Speed Switch</td>
</tr>
<tr>
<td>Momentary Switch</td>
</tr>
<tr>
<td><strong>SPEED TRIM</strong></td>
</tr>
<tr>
<td>Use a speed pot (analog input) to trim the speed switch selected set speed.</td>
</tr>
<tr>
<td>Speed Switch</td>
</tr>
<tr>
<td>Trim Pot</td>
</tr>
<tr>
<td><strong>SET SPEED WITH POT</strong></td>
</tr>
<tr>
<td>Use a speed pot (analog input) to adjust set speed.</td>
</tr>
<tr>
<td>Speed Pot</td>
</tr>
<tr>
<td><strong>SET SPEED WITH POT OR SPEED SWITCH</strong></td>
</tr>
<tr>
<td>Use a speed pot (analog input) to adjust the set speed or use a speed switch to select up to 4 discrete speeds. Use the PTO switch to select between speed pot and speed switches.</td>
</tr>
<tr>
<td>Speed Pot</td>
</tr>
<tr>
<td>Speed Switch</td>
</tr>
<tr>
<td><strong>DRIVE-BY-WIRE</strong></td>
</tr>
<tr>
<td>Use pedal pot (analog input) to adjust set speed. Can be used with or without IVS. Includes safety startup logic to assure engine always starts at idle.</td>
</tr>
<tr>
<td>Pedal</td>
</tr>
<tr>
<td><strong>DRIVE-BY-WIRE OR SPEED SWITCH</strong></td>
</tr>
<tr>
<td>Use a pedal pot (analog input) to adjust the set speed or use a speed switch to select up to 4 discrete speeds. Can be used with or without IVS. Use the PTO switch to select between pedal pot and speed switches. Drive-by-Wire mode assures that the engine will never start up at a high speed. Commanded speed will remain at idle until the pedal returns to idle. The PTO input must undergo an off-to-on transition before starting PTO mode.</td>
</tr>
<tr>
<td>Pedal</td>
</tr>
<tr>
<td>Speed Switch</td>
</tr>
</tbody>
</table>
Chapter 2.
Installing the Hardware

When installing the APECS hardware, be aware that some of the options selected may also require hardware setup (see list below). Hardware required for optional features is not provided or sold by Woodward.

Take adequate protection to ensure personal and equipment safety and follow the suggested installation sequence given below:

**Install main components:**
- Wiring  page 7
- Speed Sensor  page 12
- Actuator & Linkage  page 13

**Install optional components (hardware installation required):**
- Engine Speed Setpoint—Analog Input  page 14
- Engine Speed Setpoint—Switched Inputs  page 15
- Power Take-off Input  page 16
- Glowplug  page 17
- Autocrank  page 18
- Auxiliary Output  page 18
- Engine Protection Input  page 19

**Wiring Guidelines**

APECS 4500 has two 12-pin Deutsch connectors labeled J1 (grey) and J2 (black). Mating connectors may be purchased from Woodward (part number SA-4490) or from a Deutsch distributor.

Deutsch part numbers are as follows:

J1 (Grey): DTM06-12SA
J2 (Black): DTM06-12SB
Sockets (pins, 12 per connector): 1062-20-0122
Wedgelocks (1 per connector): WM-12S
Blank Pins (to fill empty pins): 0413-204-2005

Always use an appropriate crimping tool for attaching the pins to the wiring harness. Pay close attention to the pin numbers embossed on each connector.

**Guidelines**

Refer to Figures 2 & 3 and Tables 1 & 2 to install the system and subcomponents. Mount the unit in a location where the effects of vibration and temperature are within the specified range. Operating temperature: -40°F to +185°F (-40°C to +85°C); vibration: 6 G’s from 40 to 2000 Hz. (See Figure 2 for controller dimensions.)
Power leads are to be connected directly to a switched power source (i.e., battery). Use of a 10 amp, slow-blow fuse is recommended in the battery (positive) wire.

Use shielded cable for external speed signal source. Shields should be connected to the battery ground wire at one end only.

Use of convoluted tubing, conduit or other wire shielding is recommended to minimize the likelihood of mechanical damage to wires.

Avoid routing wires near sharp edges or near locations that can cause the wires to be “pinched” or damaged.

Use proper gauges and lengths of wire as shown in Table 1. Wire insulation should be appropriate for engine applications.

Excessive length or inadequate gauge can cause increased wire resistance that can limit the current to the actuator and prevent full actuator travel.

Increased electrical resistance can also result from poor wiring techniques. It is important to use good quality terminations and proper crimping technique during wiring.

Terminations must be impervious to moisture to prevent shorts and corrosion.

Wiring Length

Excessive resistance in the wiring will result in insufficient force from the actuator. Such increased resistance can result from too much wire length, inadequate wire gauge, or poor connections.

The following table shows the recommended gauges and maximum lengths of connecting wires for different size APECS actuators. Wire length is the total length (to and from) used to connect the actuator to the controller and the controller to the system power.

NOTE: All system wiring should be twisted pair and shielded (preferably foil shielded).

Table 1. System Wiring

<table>
<thead>
<tr>
<th>ACTUATOR*</th>
<th>AWG 14 (2.50 mm²)</th>
<th>AWG 16 (1.50 mm²)</th>
<th>AWG 18 (1.00 mm²)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0175</td>
<td>66 ft (20 m)</td>
<td>33 ft (10 m)</td>
<td>22 ft (6.7 m)</td>
</tr>
<tr>
<td>0250</td>
<td>46 ft (14 m)</td>
<td>23 ft (7 m)</td>
<td>15 ft (4.6 m)</td>
</tr>
<tr>
<td>0300</td>
<td>46 ft (14 m)</td>
<td>23 ft (7 m)</td>
<td>15 ft (4.6 m)</td>
</tr>
</tbody>
</table>

(*) The controller has a working range of 9-30 VDC. However, the actuator must be selected for either 12 or 24 VDC charging system.
Controller Wiring

The controller can be installed in the engine compartment (maximum temperature 185°F / 85°C.)

Figure 2. APECS 4500 Dimensions
### Table 2. Controller Wiring

<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>PIN INFORMATION</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actuator Output</td>
<td>ACT+ (J1-5), ACT- (J1-8)</td>
<td>—</td>
</tr>
<tr>
<td>Analog Input</td>
<td>APP (J2-12), V_{REF} (J2-11), RTN (J2-2)</td>
<td>—</td>
</tr>
<tr>
<td>Auxiliary Output</td>
<td>AUX (J2-4), V_{BAT} (J1-9)</td>
<td>Low side driver</td>
</tr>
<tr>
<td>Auxiliary Output #2</td>
<td>AUX 2 (J2-3), V_{BAT} (J1-9)</td>
<td>Low side driver</td>
</tr>
<tr>
<td>Battery</td>
<td>V_{BAT} (J1-9), GND (J1-4)</td>
<td>—</td>
</tr>
<tr>
<td>Engine Protection Input</td>
<td>EPSW (J2-9), GND (J1-4)</td>
<td>Switch to Ground</td>
</tr>
<tr>
<td>Idle Verification</td>
<td>IVS (J2-5), V_{BAT} (J1-9)</td>
<td>Switch to V_{BAT}</td>
</tr>
<tr>
<td>Power Take-off</td>
<td>PTO (J2-6), V_{BAT} (J1-9)</td>
<td>Switch to V_{BAT}</td>
</tr>
<tr>
<td>Rack Position Sensor</td>
<td>RPS (J2-1)</td>
<td>Not Used</td>
</tr>
<tr>
<td>ACT Connector</td>
<td>RCV (J1-12), TXD (J1-1), V_{BB2} (J1-11), GND2 (J1-2)</td>
<td>—</td>
</tr>
<tr>
<td>Speed Signal Input</td>
<td>RPM+ (J1-10), RPM- (J1-3)</td>
<td>—</td>
</tr>
<tr>
<td>Switched Inputs</td>
<td>SW1 (J2-7), SW2 (J2-8), V_{BAT} (J1-9)</td>
<td>Switch to V_{BAT}</td>
</tr>
</tbody>
</table>
Controller Pinout

Use the diagram below to connect your APECS controller to ACT, your preferred speed sensor, and various inputs and outputs.

Figure 3. APECS 4500 Wiring Diagram
Speed Sensor Installation

Guidelines

There are four different speed-sensing devices that can be used with the APECS 4500 system.

1. Magnetic pickup
2. Spark ignition
3. Magneto
4. Hall Effect sensor

Refer to Table 2 and Figure 3 for guidance in selecting the speed sensor suitable for your controller and application.

For magnetic pickups and Hall Effect Sensors, the mounting of the sensor unit must be rigid; excessive vibration can cause erroneous signals and unreliable performance.

Use twisted pair shielded wire for all speed sensor wiring. Shield should be grounded at the controller only.

Speed Sensor Wiring

Magnetic Pickup

Installed opposite an engine driven gear such as the flywheel, it transmits a signal each time the magnetic flux path across the pole is interrupted by a gear tooth.

Connect Pin J1-10 to the positive and Pin J1-3 to the negative side of the sensor. Most sensors do not have a positive or negative side and can be connected either way.

Spark Ignition

Intended for either traditional coil and distributor ignition or distributorless ignition systems

Traditional coil and distributor ignition; 2-, 3-, 4-, 6- and 8-cylinder engines: Connect Pin (16) to the negative side of the coil primary.

Distributorless ignition, 2-, 4-, 6- and 8-cylinder engines: Connect Pin J1-10 to the negative side of one coil primary.

May not work with ignition systems that vary the coil charging voltage (e.g. Ford TFI).
Magneto Ignition

Typically found on small 1- and 2-cylinder engines

Connect Pin J1-10 to the primary/engine kill wire and Pin J1-3 to the engine block.

Hall Effect

Located next to an engine driven gear

Connect Pin J1-10 to the sensor output and Pin J1-3 to the negative side of the sensor. The third sensor lead should be connected to battery positive.

NOTE: It is beyond the scope of this manual to discuss detailed speed sensor selection and installation for all possible applications. Please contact the factory for specific information concerning your application.

Actuator & Linkage Installation

1. Select actuator with sufficient force to move the fuel control lever from minimum to maximum fuel position. The controller has a working range of 9-30 VDC. However, the actuator must be selected for either 12 or 24 VDC charging system.

2. Select or design a bracket that correctly aligns the actuator shaft and control lever and is able to withstand the vibration level of the engine or application.

3. The linkage must have minimal friction, binding and backlash. The bracket and linkage should be designed to use as much of the actuator travel as possible.

4. Fasten actuator to bracket and bracket to engine. Attach necessary linkage between actuator shaft and fuel control lever. Move linkage end-to-end to confirm correct travel and adjust length if needed.

5. Connect actuator wires (use twisted pair with more than 1 twist per inch). Actuator travel should be adjusted to assure both maximum (start fuel or rated load) and minimum (shutdown or idle) positions.

NOTE: It is beyond the scope of this manual to discuss detailed actuator selection and installation procedures for all possible applications. Please contact the factory for specific information concerning your application.
Engine Speed Setpoint Wiring—Analog Input

Guidelines

The APECS 4500 controller features an analog speed input for mobile or stationary applications. To incorporate this feature, wire the analog input to an external pot (which must be connected to a pedal). Use Figures 6 & 7 as a guide to wire the input to your application. Potentiometer resistances of 3K–5KΩ are recommended.

Once the analog speed input is wired, refer to the APECS Calibration section to configure the appropriate parameters.

If use of an idle verification switch (IVS) is desired, hook up Pin J2-5 from the controller to the idle verification switch on the pedal. (Refer to the manufacturer’s instructions or OEM manual.) The other side of the switch should be connected to battery voltage (see Figure 7).

During engine operation, if the IVS switch and pedal pot do not agree, the engine will operate at minimum speed only.

Non-potentiometric analog voltages may also be used to command set speed. The analog voltage (0-5 volt max.) should be wired across terminals J2-12 (positive) and J1-4 (ground).

![Figure 6. Analog Input Switch](image)

![Figure 7. Analog Input Switch with IVS](image)
Engine Speed Setpoint Wiring—Switched Inputs

Guidelines

The APECS 4500 controller has two switched speed inputs for multiple speed settings. This is convenient for customers who need more than one speed for engine governing (i.e., idle speed/power speed setting or low power/high power setting).

To incorporate these switched inputs, determine the speed mode desired based on your application. The five modes available are Single Speed, Two Speed, Three Speed, Four Speed, or Variable Speed.

After determining the speed mode, select the switch hardware best suited for your application. (Switch hardware is not provided or sold by Woodward.)

Choose a switch designed for low currents (5 to 20 mA). Avoid choosing higher current devices that rely on the current to clean the switch contacts. A dry circuit switch is recommended.

The speed select switch is typically mounted on the control panel but can be mounted in any other suitable location.

Use the accompanying diagrams as a guide for wiring the selected switch to your controller.

Once the speed select switch is wired, you need to calibrate “Engine Set Speed Calibration” parameters to make the feature work. Please refer to APECS calibration chapter to configure the appropriate parameters according to the selected speed mode.

Switch Wiring

**Single Speed Mode**

No switch is needed.

**Two Speed Mode**

A toggle switch is used to select between two set speeds.
Three Speed Mode
A three-position rotary switch is used to select among three set speeds.

Four Speed Mode
A four-position rotary switch with two diodes is used to select among four set speeds.

Typical diodes that can be used with the four speed mode are 1N4001, 1N4002, up to 1N4007.

Variable Speed Mode
A momentary switch is used to ramp desired engine speed either up or down.

Power Take-off Input Wiring

Guidelines
The APECS 4500 controller offers a Power Take-off (PTO) feature that allows the controller to switch from pedal input to switched inputs for mobile applications. Alternately, the PTO input may be configured for the autocrank feature.

To use the PTO input, wire a switch to Pin J2-6 on the controller. Once the input is wired, refer to “Calibrating APECS Features” section on p. 39 to configure the appropriate parameters.

The PTO input is switched to Vbat.
Glowplug Wiring

The APECS 4500 offers a glowplug feature for remote or automatic starting of certain engines and applications. Either of the two auxiliary outputs may be configured for glowplug operation.

Wire the glowplug relay on the engine to either of the controller auxiliary outputs (low side drivers). Wire the auto-start (rocker/toggle) switch to the controller PTO input (switch to Vbat).

The diagram below shows how to wire the glowplug feature. Once the input is wired, refer to “Calibrating APECS Features” section to configure the appropriate parameters.

![Glowplug Relay Wiring Diagram](image)

Figure 9. Glowplug Relay Wiring

**NOTE**

When the glowplug feature is used, the PTO switch input cannot be used for other features.

**WARNING**

If using the glowplug feature, make sure you calibrate the controller for the glowplug feature prior to hook up. If controller is not calibrated for glowplug and the glowplug relay is hooked up, the glowplug relay may turn on as soon as power is applied to the controller. (Refer to Chapter 4 for the glowplug calibration.)
Autocrank Wiring

The APECS 4500 offers an autocrank feature for remote or automatic starting of certain engines and applications. Either of the two auxiliary outputs may be configured for autocrank operation.

Wire the crank motor relay on the engine to either of the controller auxiliary outputs (low side driver). Wire the auto-start (rocker/toggle) switch to the controller PTO input (switch to Vbat).

The diagram at left shows how to wire the autocrank feature. Once the input is wired, refer to "Calibrating APECS Features" section to configure the appropriate parameters.

NOTE
When the autocrank feature is used, the PTO switch input cannot be used for other features.

WARNING
If using the autocrank feature, make sure you calibrate the controller for the autocrank feature prior to hook up. If controller is not calibrated for autocrank and the crank motor relay is hooked up, the engine may start as soon as power is applied to the controller. (Refer to Chapter 4 the autocrank calibration.)

Auxiliary Output Wiring

A lamp or relay can be wired to either of the two auxiliary outputs on the controller for a variety of purposes: (1) to flash faults, (2) to indicate overspeed condition, (3) to indicate diagnostic shut down, (4) to indicate PTO engaged, (5) for autocrank output, and (6) for glowplug relay control.

Depending on your application, wire the lamp or relay according to the manufacturer’s specification. Once the output is wired, refer to the “Calibrating APECS Features” chapter to configure the appropriate parameters.

NOTE
If the output draws more than 200 mA, the output will be disabled and a fault code will flash.
Engine Protection Input Wiring

Optional Feature

The APECS 4500 controller offers an engine protection shutdown feature to safeguard against adverse operating conditions such as low oil pressure or high coolant temperature.

The engine protection (EP) input is a switched input similar to the set speed inputs. This input must switch to ground potential.

**Figure 13** shows how to wire the EP input. To use more than one sensor, simply wire the sensors in parallel as shown in **Figure 14**. Once the input is wired, refer to the APECS Calibration chapter to configure the appropriate parameters.
Chapter 3.
ACT Operation

ACT Installation

ACT Kit Contents

The All Purpose Calibration Tool (ACT) is used for programming (configuring and adjusting) and monitoring the APECS controller with your personal computer. The ACT kit contains the following:

- Software CD-ROM
- Interface module
- RS-232 connecting cable
- CD-ROM Installation Guide

Set-up Requirements

Hardware Requirements

- IBM compatible personal computer equipped with a CD-ROM drive and a serial port with DB-9 connector, capable of 9600 baud communication
- Windows software: 95/98/Me/2000/XP
- 64 MB of available RAM memory and a hard disk with at least 2.0 megabyte of free disk space
- SVGA capable video card and monitor, capable of 256 colors and 800 x 600 display

Software Requirements

CD-ROM of calibration tool software to run on your personal computer. (CD supplied with ACT kit.)

Hardware Set-up

To connect your PC to the APECS 4500 unit a standard RS-232 nine-pin cable and a proprietary interface module is required. Both are included in the ACT kit.

NOTE
Make sure power to the PC and the APECS unit is off when making connections. The engine may or may not be running.

Connect one end of the RS-232 cable to your PC’s COM port. Connect the other end of the cable to the interface module.

Now connect the interface module to the APECS 4500 unit via the connector on the harness. The interface harness is inserted between the J1 (grey) connector of the controller and the mating connector in the user’s wiring harness.
ACT software can be automatically installed on your hard drive from the CD-ROM supplied with the kit. To install the software on your hard drive, follow the procedures below.

**NOTE**
Make sure power to the PC and the APECS unit is off when making connections. The engine may or may not be running.

1. Turn on your computer and insert the ACT disk into the CD-ROM drive. The install program should automatically launch. If it does not, open Windows Explorer, go to the CD-ROM drive and double click on the install program.

Follow the prompts from the install program. You may select the default directory or specify your own.

When installation is complete, you may access the ACT software from the Start Menu or create your own shortcut.

The set-up is now complete and you are ready to run ACT.

- To run the ACT software, please refer to “Running the ACT Software” below.
- Put the original CD-ROM in a safe place in case the files on your hard drive are damaged or lost.
Basic ACT Operation

Running the ACT Software

The ACT software is fairly easy to use. Follow the procedures below to run the program.

1. Make certain that the APECS controller is powered up and connected to the computer’s COM port.

2. If an icon for the calibration tool exists, double click on it to start the ACT software. The license screen will be displayed when the ACT is launched. You must either accept the terms or Cancel, which exits the application.

3. If no icon exists, click on the Start button, highlight “Programs,” find the ACT software and click to start it. Default is Woodward, then select “APECS-EPS Calibration Tool.”

4. Make sure the COM port designation in ACT matches the serial port on the back of your PC.

5. Follow the procedure outlined in the Configure Menu to change the COM port assignment, if needed.

Progress Display Screen

This screen is intended to inform the user of the progress of time-consuming communication procedures. It will close automatically when the procedure is complete.

Moving Around the Software

There are five main menu items available with ACT. Several options are available under each main menu item. The discussion in the following pages assumes the cursor is at the main menu screen.

- Use mouse to select or move around the menu.
- Use left mouse to execute a command or accept a condition.
- Use function key <F1> for HELP.
- A HOT key (highlighted character in a menu item) can also be used to access or activate a menu or sub-menu, e.g. File use <ALT> <F>.
- Click on the x box in the upper right hand corner to exit ACT.
ACT Menus & Options

ACT Menu Structure

The ACT has five main menus: File Menu, Calibrate Menu, Monitor Menu, Configure Menu, and Help Menu with several options available under each. A complete discussion of all ACT menus and options is presented in the following pages.

<table>
<thead>
<tr>
<th>FILE MENU</th>
<th>CALIBRATE MENU</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save APECS Cal to File</td>
<td>Change APECS Calibration</td>
</tr>
<tr>
<td>View CAL File Comments</td>
<td>Download Cal FILE to APECS</td>
</tr>
<tr>
<td>View Text File</td>
<td>Compare APECS Cal to File Cal</td>
</tr>
<tr>
<td>Convert APECS Cal to Text</td>
<td>Change APECS Password</td>
</tr>
<tr>
<td>Convert Cal File to Text</td>
<td>APECS Calibration Wizard</td>
</tr>
<tr>
<td>Convert Cal File to Strategy</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MONITOR MENU</th>
<th>CONFIGURE MENU</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter View</td>
<td>Configure Serial Port</td>
</tr>
<tr>
<td>Parameter Plot</td>
<td></td>
</tr>
<tr>
<td>Display Faults</td>
<td></td>
</tr>
<tr>
<td>Control Strategy</td>
<td></td>
</tr>
<tr>
<td>Parameter List</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HELP MENU</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Topics</td>
<td></td>
</tr>
<tr>
<td>About ACT</td>
<td></td>
</tr>
<tr>
<td>User Manuals</td>
<td></td>
</tr>
</tbody>
</table>

File Menu

Purpose

The File Menu allows you to perform operations related to viewing, saving and converting files. The following commands are available under the File Menu.

- Save APECS Cal to File
- View Cal File Comments
- View Text File
- Convert APECS Cal to Text
- Convert Cal File to Text
- Convert Cal File to Strategy
Save APECS Cal to File

This command allows you to save APECS calibration data to a designated file. The ACT uploads the calibration set from the APECS controller and saves it to a computer file. This operation is usually done after the controller has been calibrated for satisfactory engine performance but can also be done at any other time. The data is saved in a binary file format that is not readable.

To Save APECS Cal to File:

1. Choose File → Save APECS Cal to File.

   ACT will prompt the path where the file will be saved:

2. Enter a file name to save the calibration data to.

   ACT will automatically append the file extension .ACT to the file name if you do not specify one. Click Save or press <Enter>.

   ACT will then read all of the current calibration values from the controller. This screen shows the progress.

   Once all the values are read, ACT will prompt you to add comments to the ACT file to aid in later identification.

3. If you click Yes, the comment editor screen will appear.

   To enter comments, type them one at a time and press <Enter> or click Save Edit. You can re-edit comments by clicking them, changing the text on the top line and clicking Save Edit. Comments can be deleted by clicking on them and then clicking “Delete” or by pressing <Del>.
4. Click OK on the comment editor or press <Enter> twice to save comments. Click Cancel or press <Esc> twice to close the window without saving comments. The Cal File will still be created if the comment editor is canceled.

5. The following message is displayed when the file is created successfully.

The file name in this message is the file selected in Step 2. ACT will save the calibration data to the designated file and display “Calibration Data Saved in File: ABCD.ACT” message (where ABCD is the name you entered in Step 2).

NOTE
The “Save APECS Cal to File” command stores the calibration data as an .ACT file that cannot be viewed or printed directly. Viewing and printing must be done from a converted text file. See Convert APECS Cal to Text and Convert Cal File to Text commands.

View Cal File Comments

This command allows you to display the comments that are attached to a calibration file. Users add comments when saving a calibration file. The comments help in tracking specific engine, application, and environment data for which the calibration file was created.

To View Calibration Comments:

   ACT will display a list of files on the left side of the screen with file comments on the right:

2. Use the Up and Down arrow keys to highlight the desired calibration file (.ACT extension) and view the comments attached to that file.

3. Click OK or Cancel to close Comment Viewer. The comments are created or edited when the files are created.

View Text File

This command is a convenient way to view text files.

2. ACT will prompt for a text file to view.
3. Select a file and click OK.
4. ACT will open the selected file with the default viewer for that file type.
Convert Commands

The “Save APECS Cal to File” command, discussed earlier, stores the calibration data as an .ACT file that cannot be viewed or printed directly. Viewing and printing must be done from a converted text file.

There are two convert commands available with ACT: “Convert APECS Cal to Text” and “Convert Cal File to Text.” The difference between the two commands is as follows:

1. In “Convert APECS Cal to Text” operation, the calibration set that is converted is from the APECS unit.
2. In “Convert Cal File to Text” operation, the calibration set that is converted is from a previously saved file.

You may use the View Text File command to view text files.

Convert APECS Cal to Text

This command allows you to create a text file of APECS calibration data for viewing or printing from any text editor utility in Windows. A printed copy of the calibration data can be useful for future reference.

To Convert APECS Calibration to Text:

1. Choose File \rightarrow Convert APECS Cal to Text.
2. ACT will prompt you to enter a name to save the text file. Enter a file and click OK. ACT will read all of the calibration values from the controller, create and save a text file with the parameter names, values, and units, then display the file using the default text viewer.

Convert Cal File to Text

This command allows you to convert a previously saved .ACT calibration file to a text file for viewing or printing from any text editor utility in Windows. A printed copy of the calibration data can be useful for future reference.

To Convert Cal File to Text:

1. Choose File \rightarrow Convert Cal File to Text.
2. ACT will prompt you to enter a name to save the text file. Enter a file and click OK. ACT will read all of the calibration values from the controller, create and save a text file with the parameter names, values, and units, then display the file using the default text viewer.

Convert Cal File to Strategy

This command is used to convert old ACT files for use with controllers that have a different control strategy version.

ACT will:
1. Parse through all of the calibration parameters in the old ACT file.
2. Search for the same calibration parameters in the new ACT file and assign values from the old calibration.
To Convert a Cal File to a New Strategy:

2. ACT will prompt you to enter a name to save the text file. Enter a file and click OK.

ACT will read all of the calibration values from the controller create and save a text file with the parameter names, values, and units, then display the file using the default text viewer.

Calibrate Menu

The Calibrate Menu allows you to perform operations related to APECS calibration. The following commands are available:

- Change APECS Calibration*
- Download Cal File to APECS*
- Compare APECS Cal to File Cal
- Change APECS Password*
- APECS Calibration Wizard*

(*) These commands can be password protected to prevent unauthorized calibration changes. See “Change APECS Password” for more information.

Change APECS Calibration

The “Change APECS Calibration” command allows you to calibrate (configure and adjust) various parameters associated with the APECS controller.

APECS 4500 is a programmable engine governor. Changing APECS calibration parameters is the means to configure the APECS controller for specific engines, applications and environments, and for adjusting PID gains.

The calibration parameters have been organized into categories for your convenience. Browse through the categories to view the specific parameter you want to change or adjust.

Some parameters must be set before the engine can run. Other parameters can be adjusted while the engine is running. A complete list of parameters appears in “Understanding APECS Calibration on p. 42.

All adjustments are stored immediately in non-volatile memory in the APECS unit. The APECS controller will retain the changes even if power is lost or the ACT is disconnected.

To Change APECS Calibration Parameters:

1. Choose Calibrate → Change APECS Calibration.
2. Set the “View Filter” to select a group of parameters.
3. Use F5/F6 to scroll through the list.
4. To change the highlighted parameter:
   Enter the new value in the “New Value” field
   Press <Enter>
The new value is written to the controller and then read back, with the result placed in the “APECS Value” field.

5. Press <Esc> to exit.

**Download Cal File to APECS**

The “Download Cal File to APECS” command allows you to download the entire calibration set from a file to the APECS permanent memory. This is a convenient one-step method for:

- Reverting back to a known good calibration set after experimenting with new calibration settings
- Programming multiple APECS units for a particular application

The downloaded file may have been previously configured and calibrated for satisfactory engine performance with another APECS unit.

**To Download a Cal File to APECS:**

1. Choose Calibrate → Download Cal File to APECS. The following screen allows you to select a Cal file to download.

2. Choose a file and click OK. The following screen will show the progress.

3. The following screen is shown when the operation is complete.
NOTE: During the “Download Cal File to APECS” operation, the user may encounter a situation where the Cal File password is different from that of the APECS unit. If this happens, please refer to the steps below to complete the download operation.

To Download a Cal File to APECS with a Password Different from that of the APECS Unit:

Anytime the APECS password is added or changed, the new password is stored in the unit as well as in any calibration file saved after the change.

During a “Download Cal File to APECS” operation, if the password stored in the calibration file matches the password in the unit, ACT will readily download the calibration to the APECS unit.

However, if the password stored in the calibration file does not match the password in the APECS unit, ACT will alert you of a password mismatch. Please follow the steps below to complete the download operation.

1. When a password mismatch is detected, the ACT displays a message “Cal File password differs from that of the APECS unit. Download the Cal File password to the APECS unit?”

2. If you answer Yes to this message (see note below), the calibration file will be downloaded and the password in the APECS unit will be changed to match the password stored in the calibration file.

3. If you answer No to this message, the calibration file will still be downloaded but the password in the unit will remain unchanged.

**NOTE**

Before answering Yes to the message, make sure you know the password in the calibration file. If you do not know the password, you will not be able to access the password protected features under the Calibrate menu.

Please see “Change APECS Password” command for more information on password protection.

Compare APECS Cal to File Cal

This command lets you check the differences in calibration sets between a saved file and the APECS unit. The feature is useful, for example, to ensure that the saved file matches the calibration in the APECS unit.

To Compare APECS Cal to File Cal:

1. Choose File → Compare APECS Cal to File Cal. This screen allows you to select a Cal File to compare.
2. Choose a file and Click OK. This screen will show the progress.

3. Once all parameters have been processed, a message box will list the compare results. If the parameters in the file match the controller, the following message box appears:

4. Click OK to close. If there were mismatches, the following message will appear:

You may select "Save to File" if you would like to save a permanent record of the file compare. You will then be asked to select a destination directory and file name.

Change APECS Password

This command allows you to add or change a password to protect certain calibration features. The option is useful, for example, to prevent unauthorized changes to a known good calibration set in the APECS unit.

By default, the APECS unit is not password protected.

To Change APECS Password:

1. Choose Calibrate → Change APECS Password. You will be prompted for the current password.
2. The application will query the controller to verify that the entered password matches the current password. If the password matches, the “Change” button is enabled:

3. Click “Change” and the application will prompt for the new password:

4. Enter the new password. It should be one word, no spaces, and up to 11 characters long. Once entered, click OK. The application will prompt to reenter the password to make sure that it was typed in properly:

5. Re-enter the password and click OK. If the two entries of the new password are equal, the new password will be encoded and saved in the controller.

Passwords are upper and lower case sensitive.

After changing your password, please record it in a safe place for future reference. To revert to no password protection, change APECS password to “peg,” which is the default password.

ACT Operation with the New Password:

Once a password is added or changed, the following calibration features become password protected:

Change APECS Calibration
Download Cal File to APECS
Change APECS Password
APECS Calibration Wizard
At the start of any future sessions, ACT will always prompt you to enter the new password to gain access to these features. You only need to enter the password once during any session to gain access to all the password protected features.

APECS Calibration Wizard

The APECS Calibration Wizard is an interactive guide to help you get your controller unit up and running as quickly as possible.

To Calibrate a Controller Unit Using the APECS Calibration Wizard:

2. The Wizard will give you the option to use the default calibration or modify the existing one. If you select the default calibration, the Wizard will reset all calibration parameters.
3. Press <Enter> to continue or <Esc> to abort the Wizard.
   If you press <Enter> the Wizard will lead you through the calibration process with a series of questions. When all questions have been answered the Wizard will ask you to confirm that the values entered are accurate.
4. Press <Enter> to confirm the values, <PgUp> to go back and change the values, or <Esc> to abort the Wizard.
   If you press <Enter>, the APECS Wizard will download the new calibration and reset all APECS parameters. This will complete the APECS Wizard operation.
   
   **NOTE:** The APECS Calibration Wizard only covers basic calibration. It does not automatically assure optimum engine operation. Please refer to APECS Calibration Procedures for more information.
5. You are now ready to run your engine. Press any key to go directly to the Parameter Plot screen where you can adjust the PID gains.

Monitor Menu

The Monitor Menu allows you to observe engine and APECS operation in real time. The following commands are available under the Monitor Menu.

- Parameter View
- Parameter Plot
- Display Faults
- Control Strategy
- Parameter List
**Parameter View**

This command allows you to view certain operating variables (i.e., engine speed) in real time.

**To View Parameter Values in Real Time:**

1. Choose Monitor → Parameter View. The application will launch the view screen.
2. The screen automatically starts reading values from the controller and displaying the values.
3. To stop the updating, click on Stop. The button name will then change to ‘Start.’ Clicking it again will start updating again.

**NOTE**

If any other screen is opened that requires communication with the controller while the screen is updating, the Parameter View screen will be automatically stopped.

**Parameter Plot**

The Parameter Plot command lets you view engine performance on screen in the form of a real-time graph. This feature allows you to perturb the system and observe the response to fine tune engine performance.

**To View Parameter Plot in Real Time:**

Select Monitor → Parameter Plot. The application will launch and start the parameter plot view.

The application will read the previously saved configuration and request the controller to start sending the parameter values. The controller sends the data to the PC at a rate that varies with the number of parameters being monitored. The application uses the Windows timer functionality to update the screen at the specified rate. Note that if the PC is very busy, the timer accuracy will vary, therefore, the screen and generated data files should be considered as reference only.

The X-axis time scale (25 seconds in the example screen) may be shorter than configured due to the resolution of the monitor. This value will be adjusted when the graph is resized. This also applies to the print functionality for this screen. All of the data will be recorded in a revolving buffer for use by the “Save to File” feature (see below).
The axis scales, parameter names, update resolution and time scale on the Parameter Plot may be changed as described in the Plot Setup screen.

**PID Gain Adjustments from Plot Display Screen**

After initial calibration, most engines require only a minor adjustment to PID gains to fine tune the system to its optimum level. ACT provides a convenient means of adjusting the PID gains directly from the Plot Display screen.

**To Make PID Gain Adjustments from Plot Display Screen:**

1. Press the letter <P> for proportional, <I> for integral, or <D> for derivative gain adjustment. The application will enable the gain you selected.
2. Use the Up or Down arrow keys to increase or decrease the present value. The arrow keys adjust the values by 0.004. New values may be typed in directly. Hit <Enter> after you type in a value. The application will save the new value in the APECS unit.
3. Press the <Esc> to deselect the gain adjustments.

**To Change Plot Setup:**

This allows you to choose engine rpm, desired engine speed, duty cycle or any other parameter for viewing real-time plots on screen. Axis scales can also be adjusted to fit the parameter and/or speed.

1. On the Parameter Plot screen, click on “Configure.” The application will show the following screen with the current values.

![Plot Setup Screen](image)

**Plot 1 / Plot 2**

Use the pull-down to select the desired parameter to plot.

**Axis Min / Max**

Enter the minimum / maximum value for the parameter value.

**X Axis Time Scale**

Controls how much data is displayed on the X axis. This value may automatically adjust for screen resolution.

**X Axis Sample Rate**

Controls how often the data from the controller is used to update the screen. Data received between timer ticks is discarded.
2. Clicking OK will save this information in the Windows Registry so that it will be remembered the next time the program is started.

**NOTE:** The Calibration Wizard will automatically set up the plots if there are no saved defaults.

**Display Faults**

This command allows you to display present faults in real-time. This means if new faults occur while you are monitoring, the screen will automatically update to display the current faults. The display will also show historical fault codes that have been previously logged but do not currently exist. Historical fault codes are helpful when tracking down intermittent faults.

**To Display Faults in Real Time:**

1. Choose Monitor → Display Faults from the main menu. The application will launch the Fault view.

   The application will update the display every time the controller sends the fault_flags status. This happens several times a second.

2. Click on the “Pause” button to stop the automatic update of this screen. The text on the button will change to “Start” and clicking it again will re-start the automatic updating.

   **NOTE:** If any other screen requests data from the controller while this screen is updating, this screen will automatically Pause.

**Control Strategy**

This command allows you to check the version of the control strategy in use. This information may be needed for strategy identification purposes and for future updates.

**Parameter List**

The Parameter List screen allows the user to adjust which parameters are displayed on the Parameter View display.

**To Display the Parameter List:**

1. Choose Monitor > Parameter List from the main menu.

2. The F5/F6 keys will backup/advance through the list. Press F9 or click on “On View List” to toggle the selected parameter on the Parameter View screen.
3. Click on the ‘x’ in the title bar or press <Esc> to close the screen. Edits are not saved between application launches.

4. If the Parameter View screen is already open when changes are made to the view list, close the Parameter View screen and re-open it to make the changes effective.

**Save**
Clicking Save will prompt the user for a file name to save the currently viewed configuration to.

Type in a file name that reflects the purpose of the saved configuration and click Save. The view configuration dialog will now display the selected file name in the title bar.

**Open**
Clicking Open will prompt the user for a file name of a previously saved View Configuration.

Select the desired file and click Open. The View Configuration will be updated with the saved parameters.

The ACT application will always recall the default set of plot configuration parameters at application startup, and does not recall the last used view setup file. So the view configuration will always start with the default view.

Several parameter view screens can be open with different configurations by changing the configuration on the parameter list screen (F9 or Open), then opening a new Parameter View.

**NOTE:** Only one of the parameter view screens can be monitoring the controller at once.
Configure Menu

Configure Serial Port

This command allows you to designate the proper COM port for your PC to enable communication between the ACT and the APECS controller.

To Configure the Serial Port:

1. From the main menu screen, choose Configure → Custom Serial Port. The application will display the following screen:

2. Choose a port and Click OK. This screen will be displayed on application startup if a controller cannot be found at the last selected port and can be changed any time after the application has started.

Demo Mode

This mode will use a calibration file “Demo.000” and use random numbers for values requested from the controller.

COM 1 / COM 2

This mode will look for a controller attached to the selected serial port. An error message will be displayed AFTER you click OK if a controller cannot be found or if the port cannot be opened.

COM ports outside of this range can be used by editing the default COM port registry key for this application.
Help Menu

The Help Menu provides access to the online user’s manual and other information helpful to your use of the Calibration Tool. The following commands are available under the Help Menu:

- Help Topics
- About ACT
- User’s Manual

Help Topics

This command allows you to search for specific information by displaying software menu items or through key words.

1. Click on “Contents” for an outline of the software applications listed by menu items.
2. Click on “Index” or “Find” to locate a specific topic through an alphabetical listing or by typing in a word or phrase.
3. Follow the on-screen commands to page through the manual.

About ACT

This command displays the version of the calibration tool that you are currently using. This information is important for tool identification purposes and for servicing support.

User’s Manual

This command accesses the User’s Manual, which includes comprehensive information on the APECS 4500 controller, wiring diagrams, ACT software menus, and calibration parameters. The manual may be viewed online or printed for future reference.
Chapter 4. 
Calibrating APECS Features

Calibration Guide

This section explains the procedures for calibrating (configuring and adjusting) the various APECS 4500 features to work with your application.

Before proceeding, make sure you have completed the installation of all the required hardware for your system and are familiar with using the APECS All-purpose Calibration Tool (ACT).

Safety Precautions

The APECS 4500 is a user configurable engine speed governor and will follow your settings and commands immediately. Please be aware of this when calibrating and entering values in the unit.

It is possible to enter values in the APECS unit that are in excess of what the engine is capable of performing and outside of safe operating range.

It is the user’s responsibility to be accurate when entering data into the APECS or the ACT. Entering values outside of safe operating range can result in serious physical injury and/or damage to the equipment or application.

WARNING
An overspeed shutdown device, independent of the APECS system, should be provided to prevent loss of engine control that may cause personal injury or equipment damage.

Calibration Categories

To incorporate any of the programmable features in your system, a set of parameters associated with each feature must be calibrated using the calibration tool (ACT). These parameters are grouped under various categories under the Calibrate Menu in ACT. (Refer to Table 3 below.)

Table 3. Calibration Categories and Features

<table>
<thead>
<tr>
<th>CALIBRATION CATEGORY</th>
<th>FEATURES AVAILABLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Governor Gain</td>
<td>PID Gain Settings</td>
</tr>
<tr>
<td>Engine Set Speed</td>
<td>External Pot Calibration</td>
</tr>
<tr>
<td>Speed Input</td>
<td>Speed Input Calibration</td>
</tr>
<tr>
<td>Engine Start</td>
<td>Autocrank, Glowplugs</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>Overspeed/Underspeed Protection</td>
</tr>
<tr>
<td>Actuator Output</td>
<td>Actuator Current Protection</td>
</tr>
</tbody>
</table>

NOTE: For basic APECS operation to begin, you only need to configure two parameters: PULSES_PER_REV and PULSES_PER_UPDATE (see Speed Input Configuration). All other parameters are preset to values that will work with many applications.
Calibrating an APECS Unit

Once the system set-up is complete it is fairly easy to calibrate an APECS 4500 controller.

Before proceeding with calibration, please ensure that the controller unit is connected to the COM port and powered.

Follow the steps below for calibrating your APECS controller unit.

1. If an icon for the Calibration Tool exists, double click on it to start the ACT software.

2. If no icon exists, click on the Start button, highlight “Programs,” find the ACT software and click to start it.

3. Make sure the COM port designation in ACT matches the serial port on the back of your PC.

   Follow the procedure outlined in the Configure Menu to change the COM port assignment, if needed.

4. If you do not use the Wizard, calibrate the speed input for the type of speed sensor, SPEED_TYPE as well as the appropriate values for PULSES_PER_REV and PULSES_PER_UPDATE. “Refer to Speed Input Configuration Parameters.”

5. If you wish to use the Wizard for basic calibration, refer to “APECS Calibration Wizard.” The Wizard is an interactive guide to help you get your controller running as quickly as possible.

6. Beyond basic calibration, there are many parameters associated with APECS that can help enhance the performance of your engine. Read the section on “Understanding APECS Calibration Parameters” and decide on the parameters you would like to adjust.

7. Access “Change APECS Calibration” option from the Calibrate menu and select the desired parameter from the appropriate category. Adjust the value of the parameter as needed.

8. Repeat Step 5 until all desired parameters have been adjusted and satisfactory engine performance has been achieved.

9. You do not need to save the new calibration settings. All settings are automatically saved in the controller and remain in memory after shutdown.

Saving a Calibration Set to File

After satisfactory engine performance is achieved, it is recommended that you save the calibration set to a file.

- A saved file allows you to experiment with other calibration settings and still be able to recall the saved calibration set.
- A saved calibration set can be used for configuring additional APECS units.

To Save a Calibration Set to File:

1. Access the File Menu to activate the “Save APECS Cal to File” command.
2. Enter a file name to save the calibration data to a designated file.

3. When prompted to edit the comment list, enter information that will help you keep track of specific engine, application and environment data associated with the file.

4. ACT will save the calibration set and automatically append the file extension “.ACT” to the file name.

Calibrating an APECS Unit with a Saved Calibration File

You may wish to calibrate additional APECS units with a saved calibration file for consistent, optimized operation.

To Calibrate an APECS Unit with a Saved Calibration File:

1. Access the Calibrate menu to activate the “Download Cal File to APECS” command.

2. Select the appropriate file to download (refer to the comment list on the right side of the screen to help identify the desired file). Enter password if prompted.

3. ACT will download file calibration to APECS permanent memory.

4. Repeat Steps 1 and 2 if multiple APECS units are to be calibrated.

NOTE: The APECS unit must be powered up, but need not be mounted on the engine to carry out the calibration procedure.
Understanding APECS Calibration Parameters

This section provides answers to frequently asked questions about calibration parameters, lists parameters, and provides calibration procedures.

Frequently Asked Questions

What is a calibration parameter?
A parameter is a numerical value that helps the calibrator adjust or set the APECS controller. Once fixed by a calibrator, the parameter is not subject to change while the system is operating. APECS calibration parameters are used not only to adjust and set the controller but also to configure it properly for different applications.

Why do we need to calibrate the APECS system?
APECS 4500 is a software programmable system and has no manual adjustment. Calibrating is the only means of configuring and adjusting the controller for your specific application.

Do I need to calibrate ALL the parameters to make my system work?
No. Two parameters, PULSES_PER_UPDATE and PULSES_PER_REV, are factory set to prevent the APECS unit from calculating an engine speed and driving the actuators. These two parameters must be calibrated to a non-zero value before normal APECS operation can begin. Other parameters are preset to values that will work with many engines and applications. However, it is recommended that you review all settings for your own application.

Is it possible to enter values in APECS in excess of what the application is capable of performing?
Yes. While ACT (the calibration tool) restricts you from entering values outside of the specified range, the range itself is fairly wide and it is possible to enter values in excess of what your application is capable of performing.

For example, it is possible to command engine speeds up to 8192 rpm with ACT. Your engine may or may not be able to operate at this speed. It is also possible to damage the generator or pump attached to your engine by commanding maximum engine speed because while the engine may be capable of performing at the rated rpm, the generator or pump is likely to have a lower rpm rating than the engine.

Furthermore, there are certain parameters that are used to properly configure an application. Entering incorrect values for these parameters will result in improper configuration and may make the engine run at maximum throttle. Entering values outside of safe operating range can result in serious physical injury and/or damage to the equipment.
### List of Parameters

<table>
<thead>
<tr>
<th>CATEGORY</th>
<th>PARAMETER</th>
<th>DESCRIPTION</th>
<th>FACTORY CAL</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Governor Gain Calibration</strong></td>
<td>DERIVATIVE_GAIN</td>
<td>Speed stability</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>INTEGRAL_GAIN</td>
<td>Steady state speed</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>PROPORTIONAL_GAIN</td>
<td>Transient response</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>MASTER_GAIN</td>
<td>Combined PID gain response</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>BRAKE_DELAY</td>
<td>Delay for return to idle, mode 023</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>EXTERNAL_ANALOG_MODE</td>
<td>External analog input configuration</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>RAMP_DOWN_RATE</td>
<td>Engine speed ramp down rate</td>
<td>1000</td>
</tr>
<tr>
<td></td>
<td>RAMP_UP_RATE</td>
<td>Engine speed ramp up rate</td>
<td>1000</td>
</tr>
<tr>
<td></td>
<td>SET_SPEED_1</td>
<td>Engine set speed 1</td>
<td>1800</td>
</tr>
<tr>
<td></td>
<td>SET_SPEED_2</td>
<td>Engine set speed 2</td>
<td>1900</td>
</tr>
<tr>
<td></td>
<td>SET_SPEED_3</td>
<td>Engine set speed 3</td>
<td>2000</td>
</tr>
<tr>
<td></td>
<td>SET_SPEED_4</td>
<td>Engine set speed 4</td>
<td>2500</td>
</tr>
<tr>
<td></td>
<td>SET_SPEED_MAX</td>
<td>Maximum increment speed</td>
<td>2600</td>
</tr>
<tr>
<td></td>
<td>SET_SPEED_MIN</td>
<td>Minimum decrement speed</td>
<td>1000</td>
</tr>
<tr>
<td></td>
<td>SET_SPEED_TRIM</td>
<td>Engine trim speed (rpm)</td>
<td>200</td>
</tr>
<tr>
<td></td>
<td>SET_SPEED_WARMUP</td>
<td>Engine warm up speed</td>
<td>1800</td>
</tr>
<tr>
<td></td>
<td>SPEED_DECREASE_DELAY</td>
<td>Multi-speed decrease delay time (sec)</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>SWITCH_CONFIGURATION</td>
<td>1,2,3,4: multispeed, 5: variable speed</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>WARM_UP_TIME</td>
<td>Time spent at warm up speed</td>
<td>0</td>
</tr>
<tr>
<td><strong>Engine Set Speed Calibration</strong></td>
<td>SPEED_TYPE</td>
<td>Mag Pickup = 128</td>
<td>128</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Coil Ignition = 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Magneto = 3</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Hall Effect = 131</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PULSES_PER_REV</td>
<td>No. of pulses per engine revolution</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>PULSES_PER_UPDATE</td>
<td>No. of pulses until next engine speed update</td>
<td>0</td>
</tr>
<tr>
<td><strong>Speed Input Configuration</strong></td>
<td>AUTOCRANK_CRANK_TIME</td>
<td>Time autocrank holds crank solenoid on (sec)</td>
<td>5</td>
</tr>
<tr>
<td><strong>Engine Start Calibration</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CATEGORY</td>
<td>PARAMETER</td>
<td>DESCRIPTION</td>
<td>FACTORY CAL</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------</td>
<td>--------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>AUTOCRANK_MAX_TRIES</td>
<td>Number of autocrank attempts</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>AUTOCRANK_REST_TIME</td>
<td>Rest time between autocrank attempts (sec)</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>CRANK_DUTY_CYCLE</td>
<td>Kickoff duty cycle for open-loop cranking</td>
<td>0.945</td>
</tr>
<tr>
<td></td>
<td>GLOWPLUG_TIME</td>
<td>Time glowplugs pre-heat before autocrank</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>KEY_ON_DUTY_TIME</td>
<td>Time at no-start and key-on to drive duty cycle</td>
<td>0</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>ENGINE_PROTECT_RUN_TIME</td>
<td>Engine run time before checking switch (8000 = disabled)</td>
<td>8000</td>
</tr>
<tr>
<td>Calibration</td>
<td>ENGINE_PROTECT_TIME</td>
<td>Switch delay before engine protection shutdown</td>
<td>1000</td>
</tr>
<tr>
<td></td>
<td>OVERSPEED_RPM</td>
<td>Actuator shutdown speed (max)</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>UNDERSPEED_RPM</td>
<td>Actuator shutdown speed (min)</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>UNDERSPEED_RUN_TIME</td>
<td>Run time before underspeed is checked</td>
<td>10</td>
</tr>
<tr>
<td>Actuator Output</td>
<td>AUX_OUTPUT_RPM</td>
<td>Drive aux. output when above this engine rpm</td>
<td>700</td>
</tr>
<tr>
<td>Calibration</td>
<td>AUX_OUTPUT_2_RPM</td>
<td>Drive aux. output #2 when above this engine rpm</td>
<td>700</td>
</tr>
<tr>
<td></td>
<td>AUXILIARY_OUTPUT_MODE</td>
<td>0: no output 1: use RPM 2: critical shutdown 3: PTO 4: autocrank 5: mimic LED 6: glowplug</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>AUXILIARY_OUTPUT_2_MODE</td>
<td>0: no output 1: use RPM 2: critical shutdown 3: PTO 4: autocrank 5: mimic LED 6: glowplug</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>DROOP_PERCENT</td>
<td>%</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>HIGH_ACTFDBK_LMX</td>
<td>Actuator current limit</td>
<td>500</td>
</tr>
</tbody>
</table>
Calibration Procedures: PID Gains Adjustment

These parameters allow proportional, integral and derivative gains to be programmed by the user.

Calibration Parameters Needing Configuration:

DERIVATIVE_GAIN
Engine speed governor derivative gain (unitless).

Derivative gain is used to improve stability. Increase derivative gain until response has a slight overshoot on load transients.

INTEGRAL_GAIN
Engine speed governor integral gain (unitless).

Integral gain is used to remove steady-state errors. Increase integral gain until speed begins to oscillate, and then decrease until oscillation stops. If oscillations do not occur, bump actuator lever, then decrease integral gain until oscillation stops.

PROPORTIONAL_GAIN
Engine speed governor proportional gain (unitless).

Proportional gain is used to improve response time. A maximum amount of proportional gain should be used while still maintaining stability. Increase proportional gain until speed begins to oscillate, then decrease until oscillation stops. If oscillations do not occur, bump actuator lever, then decrease proportional gain until oscillation stops.

MASTER_GAIN
As a multiplier to the PID gains, master gain is used to increase or decrease the combined derivative, integral, and proportional response with a single gain.

For example, the effective proportional gain used is PROPORTIONAL_GAIN X MASTER_GAIN. This permits adjusting all three gains with a single calibration parameter. Range: 0-255. Default value: 1.0.

PID Gain Settings Response Plots

ACT allows the user to adjust the P, I, and D gain settings and observe the response directly on screen in the form of a real-time plot. The plots on the following page illustrate the various conditions a user may encounter while tuning an application. Although conditions may vary according to application and nature of load, these plots are typical of what is often observed.

Figures 16–20 illustrate less desirable conditions often encountered while tuning an application and suggest probable causes.

Figure 21 shows a plot of a properly tuned application. Although conditions may vary according to application and nature of load, this plot is typical of what is often desired.
Engine Set Speed Calibration Parameters

Calibration Procedures

The APECS 4500 has two primary means of selecting engine speed setpoint:

- Using analog speed setpoint (EXTERNAL_ANALOG_MODE)
- Using switched speed setpoint (SWITCH_CONFIGURATION)

To make the controller suitable for many mobile and stationary applications, there are a variety of ways the speed switches and the speed pot can be configured (e.g., independently or together).

Calibration Parameters Needing Configuration:

The two primary parameters are:

NOTE: Excessive friction and slop in the linkage are primary contributors to poor governor stability. If it is not possible to stabilize engine performance, check smoothness of the linkage.
EXTERNAL_ANALOG_MODE
This is the main parameter that defines how the analog APP input is interpreted for selecting desired engine set speed.

Speed selection may be based on the analog input, the speed select switches, or a combination of the two. See Table 4, External Analog Input Modes.

SWITCH_CONFIGURATION
This parameter is used to let the software know how the user has configured the speed switch inputs.

Calibrate SWITCH_CONFIGURATION according to the selected speed mode. There are five switch configurations available: Single Speed, Two Speed, Three Speed, Four Speed, and Variable Speed. See Table 5, Switch Configuration Modes.

Parameters Used with the Two Primary Parameters:

BRAKE_DELAY
When external analog mode is set to 23, this parameter is used to specify the delay, in seconds, for automatic return to idle once the IVS input indicates no load on the engine.

Range: 0-31.875 seconds. Once the timer times out, SET_SPEED_MIN will be commanded, regardless of whether the controller is in pedal mode or PTO mode.

RAMP_DOWN_RATE
Rate at which command engine speed decreases from one set point to a lower set point (rpm/second)

RAMP_UP_RATE
Rate at which commanded engine speed increases from one set point to a higher set point (rpm/second)

SET_SPEED_1
Preset engine speed 1 (rpm). Used when SWITCH_CONFIGURATION = 1-4

SET_SPEED_2
Preset engine speed 2 (rpm). Used when SWITCH_CONFIGURATION = 2-4

SET_SPEED_3
Preset engine speed 3 (rpm). Used when SWITCH_CONFIGURATION = 3-4

SET_SPEED_4
Preset engine speed 4 (rpm). Used when SWITCH_CONFIGURATION = 4

SET_SPEED_MAX
Highest engine speed command possible when using push-button switches to ramp engine speed up (rpm). (SWITCH_CONFIGURATION = 5)

Also used to specify the maximum rpm commanded with an analog input.

SET_SPEED_MIN
Lowest engine speed command possible when using variable speed mode to ramp engine speed down (rpm). (SWITCH_CONFIGURATION = 5).

Also used to specify the minimum rpm commanded with an analog input.
SET_SPEED_TRIM
Amount speed may be trimmed with external pot above/below set speed.

SET_SPEED_WARMUP
Engine speed set point used immediately after engine has started running (rpm.)

SPEED_DECREASE_DELAY
When in multi-speed mode 2, 3, or 4 and the speed switch input is changed to select a lower speed, this is the delay before the engine speed command is ramped to a new lower speed (seconds).

This is useful for applications that are continuously switched on and off such as welding machines.

WARMUP_TIME
Length of time to hold engine at warmup speed immediately after engine has started running (seconds). Setting WARMUP_TIME to zero disables the warmup feature

NOTE: All switch inputs are switched to Vbat.

External Analog Input Calibration (with IVS)

Use the external analog input for a variety of functions such as (1) Pedal position sensor with idle verification switch, (2) Remote speed adjustments, and (3) Trim potentiometer. See “Auxiliary Output Wiring” for wiring analog inputs.
# Table 4. External Analog Input Modes

<table>
<thead>
<tr>
<th>MODE</th>
<th>CONFIGURATION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>000</td>
<td>No external analog input</td>
<td>Use speed switch or momentary switch.</td>
</tr>
<tr>
<td>001</td>
<td>Trim mode</td>
<td>Use external pot to trim the selected set speed. The speed selected by the set speed switches is adjusted by plus or minus SET_SPEED_TRIM. The set speed is bounded by SET_SPEED_MIN and SET_SPEED_MAX.</td>
</tr>
<tr>
<td>101</td>
<td>Trim mode, reverse pot*</td>
<td></td>
</tr>
<tr>
<td>002</td>
<td>Set speed with pot</td>
<td>Use external pot to adjust set speed between SET_SPEED_MIN and SET_SPEED_MAX.</td>
</tr>
<tr>
<td>012</td>
<td>Set speed with pot, PTO available</td>
<td>PTO is available where indicated and allows switching from pot selected speed to switch selected speed. Auxiliary output can be configured to indicate the PTO state. Ramp rate limits are still in effect.</td>
</tr>
<tr>
<td>102</td>
<td>Set speed with reverse pot</td>
<td></td>
</tr>
<tr>
<td>112</td>
<td>Set speed with reverse pot*, PTO available</td>
<td></td>
</tr>
<tr>
<td>003</td>
<td>Drive-by-wire, no IVS</td>
<td></td>
</tr>
<tr>
<td>013</td>
<td>Drive-by-wire, no IVS, PTO available</td>
<td></td>
</tr>
<tr>
<td>103</td>
<td>Drive-by-wire, IVS open at idle</td>
<td>Can be used with an IVS (idle verification switch). PTO is available where indicated and allows switching from pedal pot selected speed to switch selected speed. Auxiliary output can be configured to indicate the PTO state. Ramp rate limits are still in effect.</td>
</tr>
<tr>
<td>113</td>
<td>Drive-by-wire, IVS open at idle</td>
<td></td>
</tr>
<tr>
<td>203</td>
<td>Drive-by-wire, IVS closed at idle</td>
<td></td>
</tr>
<tr>
<td>213</td>
<td>Drive-by-wire, IVS closed at idle, PTO available</td>
<td></td>
</tr>
<tr>
<td>023</td>
<td>Drive-by-wire, PTO available, brake mode</td>
<td>Uses IVS as brake input—will do automatic return to idle (SET_SPEED_MIN) when IVS is active for longer than BRAKE_DELAY seconds. Otherwise, similar to Mode 013.</td>
</tr>
<tr>
<td>255</td>
<td>APS calibration mode. See “External Pot Calibration”</td>
<td>Allows an external pot from various applications to interface properly with the controller.</td>
</tr>
</tbody>
</table>

(*) Reverse pot option reverses speed increase/decrease relationship to a clockwise rotation of pot.
CAUTION
If a drive-by-wire mode is being used (003, 013, 023, 103, 113, 203, 213) the engine is not allowed to start up in PTO mode.

PTO is locked out until the engine has started and the PTO switch is transitioned from its off position.

Switch Configuration Modes

Use the switched inputs and speed setpoint parameters to set up to four discrete speeds and set ramp rates between speeds OR use the inputs to manually increase or decrease speed at preset rates with variable speed control. Refer to “Auxiliary Output Wiring” for wiring switch inputs.

Table 5. Switch Configuration Modes

<table>
<thead>
<tr>
<th>CONFIGURATION MODE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>= 1: SINGLE SPEED</td>
<td>A single engine speed is commanded. The engine is started and transitions from crank mode to run mode. The commanded engine speed will increase from SET_SPEED_MIN to SET_SPEED_WARMUP at the RAMP_UP_RATE. Engine speed remains at the warm up speed for WARMUP_TIME seconds, after which the engine speed either increases at RAMP_UP_RATE or decreases at RAMP_DOWN_RATE to SET_SPEED_1.</td>
</tr>
<tr>
<td>= 2: TWO SPEED</td>
<td>A switch is used to select between two set speeds. The engine is started and transitions from crank mode to run mode. The commanded engine speed will increase from SET_SPEED_MIN to SET_SPEED_WARMUP at the RAMP_UP_RATE. Engine speed remains at the warm up speed for WARMUP_TIME seconds, after which the engine speed either increases at RAMP_UP_RATE or decreases at RAMP_DOWN_RATE to the speed selected by the switch (SET_SPEED_1 or SET_SPEED_2). When the other speed is selected with the switch, commanded engine speed is ramped to the new set speed.</td>
</tr>
<tr>
<td>= 3: THREE SPEED</td>
<td>A rotary switch is used to select among three set speeds. The engine is started and transitions from crank mode to run mode. The commanded engine speed will increase from SET_SPEED_MIN to SET_SPEED_WARMUP at the RAMP_UP_RATE. Engine speed remains at the warm up speed for WARMUP_TIME seconds, after which the engine speed either increases at RAMP_UP_RATE or decreases at RAMP_DOWN_RATE to the speed selected by the rotary switch (SET_SPEED_1 to SET_SPEED_3). When another speed is selected with the switch, the commanded engine speed is ramped to the new set speed.</td>
</tr>
</tbody>
</table>
### CONFIGURATION MODE

<table>
<thead>
<tr>
<th>MODE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>= 4: FOUR SPEED</td>
<td>A rotary switch with two diodes is used to select among 4 set speeds. The engine is started and transitions from crank mode to run mode. The commanded engine speed will increase from [ \text{SET_SPEED_MIN} ] to [ \text{SET_SPEED_WARMUP} ] at the [ \text{RAMP_UP_RATE} ]. Engine speed remains at the warm up speed for [ \text{WARMUP_TIME} ] seconds, after which the engine speed either increases at [ \text{RAMP_UP_RATE} ] or decreases at [ \text{RAMP_DOWN_RATE} ] to the speed selected by the rotary switch ( \text{SET_SPEED_1} ) to ( \text{SET_SPEED_4} ). When another speed is selected with the switches, the commanded engine speed is ramped to the new set speed.</td>
</tr>
<tr>
<td>= 5: VARIABLE SPEED</td>
<td>A momentary switch is used to ramp desired engine speed either up or down. The engine is started and transitions from crank mode to run mode. The commanded engine speed will increase from [ \text{SET_SPEED_MIN} ] to [ \text{SET_SPEED_WARMUP} ] at the [ \text{RAMP_UP_RATE} ]. Engine speed remains at the warm up speed for [ \text{WARMUP_TIME} ] seconds, after which the user may select a new speed by using the switches, which will either increase or decrease engine speed. A brief pressing of the switch will change engine speed by one rpm. Holding the switch closed longer will ramp the engine speed command, first at a slow rate, then at either [ \text{RAMP_UP_RATE} ] or [ \text{RAMP_DOWN_RATE} ], depending on which direction the switch is being pressed. The engine speed command will never ramp above [ \text{SET_SPEED_MAX} ] or below [ \text{SET_SPEED_MIN} ].</td>
</tr>
</tbody>
</table>

### External Pot Calibration

This feature allows an external pot from a variety of applications to interface properly with the APECS 4500. Refer to **Table 4** for mode configurations and descriptions.

**Calibration Parameters Needing Configuration:**

**EXTERNAL\_ANALOG\_MODE**

Allows the external analog input to be configured in a variety of ways.

**Calibration Procedures**

The calibration procedure is automatic. Simply set the parameter **EXTERNAL\_ANALOG\_MODE** to 255 (refer to **Table 4**) and run the external pot or pedal up and down through its full range of travel. The controller will automatically learn and store the minimum and range values in its memory. Set **EXTERNAL\_ANALOG\_MODE** back to the desired speed mode when finished.
PTO Input

This feature allows selection between pedal input and speed switches in mobile applications.

Calibration Parameters Needing Configuration:

**AUXILIARY_OUTPUT_MODE**
This logic value lets the software know how the auxiliary output is configured.
Set Auxiliary_Output_Mode = 3 to turn on an indicator lamp when in PTO mode.

**EXTERNAL_ANALOG_MODE**
This logic value lets the software know how the external analog input is configured (see “Calibrating APECS Features”).

**SWITCH_CONFIGURATION**
This logic value lets the software know how the speed switch inputs are configured.

Calibration Procedures

Select the appropriate analog input mode and configure the external analog and switched inputs according to your application.

In the PTO “ON” mode, select the speed with speed switches. In PTO “OFF” mode, use the pedal or the pot to adjust the speed.

As a safety feature (in drive-by-wire mode only), when the engine is initially turned on, the mode is assumed to be PTO “OFF” regardless of the PTO switch setting. Users have to cycle the PTO switch “OFF” and then back “ON” to enable PTO input.

**CAUTION**
If a drive-by-wire mode is being used (003, 013, 023, 103, 113, 203, 213) the engine is not allowed to start up in PTO mode.

PTO is locked out until the engine has started and the PTO switch is transitioned from its off position.

Set Speed Calibration FAQ

After a power down/power up reset, does APECS remember the last speed it was using?

No. The only data APECS retains after power down are the calibration parameter settings. If you are using the variable speed mode, you will have to reestablish the desired speed after the engine is restarted.

However, if you are configured for one of the four set speed modes, then APECS will command the same speed on the next power up, after an optional warm up period, as long as the switches haven’t been changed.

If using variable speed mode, what is the initial speed command when the engine starts?

SET_SPEED_WARMUP. Even if WARMUP_TIME is set to 0, this will be the initial engine speed command. It does not change until the engine is running and the toggle switch is pressed. The toggle switch has no effect when the engine is not running.
If using the 4-speed modes, what is the initial speed command when the engine starts?
That depends on your use of a warm up speed. If you're using a warm up speed, enabled by setting WARMUP_TIME to a non-zero value, then the first speed commanded will be SET_SPEED_WARMUP. If you are not using a warm up speed, disabled by setting WARMUP_TIME to zero, then the first speed commanded is selected by the speed switches.

Can I command the engine to stop without powering down APECS?
Yes, if you are using 2-, 3-, or 4-speed mode. Simply set one of the set speeds to 1. When you select that speed with the switch, the engine will follow the command to 1. Usually powering off the APECS unit shuts down the engine and the throttle is immediately closed. However, if you command a shutdown with the switch, and the ramp down rate is set low, the engine will be stopped in a 'soft shutdown' manner.

When the engine starts, does the desired engine speed jump right to the initial speed command?
No. For a smoother start, desired engine speed ramps to the initial speed command from SET_SPEED_MIN. SET_SPEED_MIN is independent from the other 4 set speeds. It may be set to any value, above or below the other speeds. The recommended value for SET_SPEED_MIN is the low idle speed of the engine. Remember that SET_SPEED_MIN is also the minimum variable speed commanded when lowering engine speed with the toggle switch.

**Speed Input Configuration Parameters**

**Calibration Procedures**

SPEED_TYPE electrically configures the input circuitry for the speed input type and also specifies how electrical noise is to be detected and rejected.

PULSES_PER_UPDATE and PULSES_PER_REV are factory set to prevent the unit from calculating an engine speed and driving the actuator.

These two parameters must be calibrated to a non-zero value before normal APECS operation can begin.

**Calibration Parameters Needing Configuration:**

**SPEED_TYPE**

Factory set for a mag pickup. This parameter electrically configures the input circuitry for the speed input type and also specifies how electrical noise is to be detected and rejected. Recommended values are as follows:

- Mag Pickup: 128
- Coil Ignition: 2
- Magneto Ignition: 3
- Hall Effect Sensor: 131

**PULSES_PER_UPDATE**

The number of pulses received by the controller between engine speed calculations and updates.

The fewer the pulses, the faster the update rate and the lower the resolution; the greater the pulses, the greater the averaging effect on calculated engine speed. Factory set to zero. Must be non-zero to operate.
PULSES_PER_REV
The number of teeth on the engine speed pickup wheel (mag pickup input and Hall Effect sensor), or the number of spark pulses per engine rev (ignition input).

To figure out the pulses per revolution, you must determine the kind of speed signal input used on your application:

- **Magnetic Pickup Input or Hall Effect Sensor**
  
Pulses per revolution = number of teeth on the flywheel

- **Woodward Mini-Gen® Signal Generator**
  
Pulses per revolution = 0.5 x drive ratio if Mini-Gen is driven at other than crankshaft speed

- **Spark Ignition Input**
  
Pulses per revolution = 1 for single cylinder engine with magneto and one wasted spark
  
Pulses per revolution = number of cylinders / 2 for multi cylinder engine with distributor

PULSES_PER_REV FAQ

**How does PULSES_PER_REV work when using the ignition signal for engine speed?**

When an ignition signal is used to detect engine speed, the input pulses relate directly to cylinder firing events rather than teeth on a flywheel. The controller measures the time between the input pulses from the ignition. To accurately calculate engine speed, it must know how many ignition pulses are occurring in each engine revolution; this is PULSES_PER_REV.

The number of ignition pulses per engine revolution will vary depending on the engine type. Factors that must be known include: how many cylinders the engine has, whether there is a distributor, and if a waste spark is generated.

**Are there any general guidelines?**

Yes. Single cylinder engines typically use a magneto with a firing spark and a wasted spark. The firing spark occurs at the end of the compression stroke, once every 2 engine revs. The wasted spark occurs at the end of the exhaust stroke, 360° later. Therefore, the signal from the ignition will have one pulse per engine revolution.

PULSES_PER_REV = 1.

With multi-cylinder engines using a distributor, the primary ignition signal will have one pulse for every cylinder-firing event. Since each cylinder is fired every 2 revs, PULSES_PER_REV = number of cylinders ÷ 2.

PULSES_PER_REV must be an integer; no half pulses allowed. The ignition signal from a 3-cylinder engine will have 3 pulses per 2 engine revs, which works out to 1.5 pulses per engine rev.

To work around this situation, assign PULSES_PER_REV = 3. Then the calculated engine speed will be exactly half actual speed. If the engine is operating at 1800 rpm, displayed engine speed will be 900 rpm. Therefore all set speeds must be half of the actual target speed.

**CAUTION:** If you forget and set the desired speed to 1800 rpm, the engine will speed up to 3600 rpm in order to reach the target.
Engine Start Calibration Parameters

This section covers parameters for engine start calibration.

Glowplug Control

On a command from an auto-start switch (using PTO input), the auxiliary output can be configured to turn on a glowplug relay before engaging the autocrank relay. The glowplug relay will remain on until the engine starts or until the autocrank sequence completes the maximum permissible number of crank cycles. This feature is useful for remote operation of certain engines or applications.

Calibration Parameters Needing Configuration:

AUXILIARY_OUTPUT_MODE
This parameter is used to let the software know how the auxiliary output of APECS 4500 is to be configured. Set to a value of 6 for glowplug control. See “Auxiliary Outputs” for settings.

AUXILIARY_OUTPUT_2_MODE
This parameter is used to let the software know how auxiliary output #2 of APECS 4500 is to be configured. Set to a value of 6 for glowplug control. See “Auxiliary Outputs” for settings.

GLOWPLUG_TIME
This parameter specifies the pre-heat time, in seconds, before the autocrank relay is engaged.

Calibration Procedures

The glowplug feature is enabled by setting AUXILIARY_OUTPUT_MODE or AUXILIARY_OUTPUT_2_MODE to 6.

When the auto-start switch is made, the glowplug output becomes active for GLOWPLUG_TIME (sec) before the autocrank relay is engaged.

Autocrank

On a command from an auto-start switch (using PTO input), an engine will go through an autocrank sequence (using auxiliary output). This feature is useful for remote operation of certain engines or applications.

Caution: To effectively use the autocrank feature, the actuator should be able to stop the engine, otherwise an ignition cutoff type system must be provided.

Calibration Parameters Needing Configuration:

AUTOCRANK_CRANK_TIME
Specifies the maximum time, in seconds that the engine will crank. If the engine starts during the crank period, engine cranking will be terminated. Range: 0-31.9 seconds.

AUTOCRANK_MAX_TRIES
Maximum number of crank/rest cycles before autocrank logic stops trying to start the engine and flags a fault. Range: 0-255.
AUTOCRANK_REST_TIME
If the engine does not start during the cranking interval, cranking will be disabled for AUTOCRANK_REST_TIME seconds in order to permit the starter motor to cool. Range: 0-31.9 seconds.

AUXILIARY_OUTPUT_MODE
This parameter is used to let the software know how the auxiliary output of APECS 4500 is to be configured. See “Auxiliary Outputs” for settings.

AUXILIARY_OUTPUT_2_MODE
This parameter is used to let the software know how auxiliary output #2 of APECS 4500 is to be configured. See “Auxiliary Outputs” for settings.

Calibration Procedures

The autocrank feature is enabled by setting AUXILIARY_OUTPUT_MODE or AUXILIARY_OUTPUT_2_MODE to 4. PTO is not available with autocrank.

When the auto-start switch is made, the autocrank output waits GLOWPLUG_TIME seconds then becomes active for AUTOCRANK_CRANK_TIME (sec) or until the engine starts. If the engine does not start, then the output goes inactive for AUTOCRANK_REST_TIME (sec), and then another crank attempt is made. The sequence is repeated for AUTOCRANK_MAX_TRIES. If the engine has not started after the maximum crank attempts have been made, a fault is flagged.

When the auto-start switch is turned off, actuator duty cycle is set to zero to shut down the engine.

Engine Cranking

The engine cranking parameters control how APECS will drive the actuator during cranking.

Calibration Parameters Needing Configuration:

CRANK_2_RUN
Speed transition point indicating engine has gone from crank mode to run mode (rpm). Once engine rpm rises above CRANK_2_RUN rpm, it is assumed that the engine is in run mode.

CRANK_DUTY_CYCLE
The fixed duty cycle used to drive the actuator when the engine is cranking (percent).

May be calibrated to a maximum duty cycle for diesel engines that require full rack for starting, or a minimum duty cycle for some spark-ignition engines that require closed throttle for starting.

NOTE: This parameter is preset to a value that will work with most engines and applications. Entering new values for these parameters is optional.

KEY_ON_DUTY_TIME
The actuator will be driven at CRANK_DUTY_CYCLE following key-on reset for KEY_ON_DUTY_TIME (in seconds) while there is no input speed signal. Once a valid speed signal is detected, normal operation ensues. This is useful for applications that do not generate a speed input signal at crank (e.g. genset which senses engine speed from the generator output). When using this feature, the duty cycle does not cut back until a valid input speed signal is seen, or the timeout period is up. If there is never a
valid input speed, the actuator will continue to be driven at CRANK_DUTY_CYCLE even if the engine is running. This could lead to an overspeed situation. Default value: 0

**Calibration Procedures**

CRANK_DUTY_CYCLE may be calibrated to a maximum duty cycle for diesel engines that require full rack for starting, or a mid-range duty cycle for some spark-ignition engines that require a partially open throttle for starting.

In run mode, control is closed-loop; the actuator is driven as necessary to maintain the set desired speed.

Setting KEY_ON_DUTY_TIME (seconds) to a non-zero value will cause the actuator to be driven to the crank duty cycle, even if no engine speed signal is present. The actuator is energized at key-on reset for the set amount of time. This may be useful for generator applications where it is desirable to sense engine speed from the generator frequency.

To keep speed voltage below $75 \, V_{rms}$, a step down transformer may be necessary. When this feature is used, it is especially important to have a redundant overspeed protection device because a broken speed input wire could cause the engine to run at wide open throttle for up to KEY_ON_DUTY_TIME.

**Diagnostics Calibration Parameters**

This section covers diagnostic calibration parameter configuration.

**Engine Protection Input**

User selectable input to protect against adverse conditions such as high coolant temperature or low oil pressure. In case of oil pressure, allows the engine time for oil pressure to rise following startup.

**Calibration Parameters Needing Configuration:**

**ENGINE_PRTCT_RUN_TIME**

The time, in seconds, that the engine must be running before the engine protection logic begins to monitor the engine protection input.

This permits the APECS 4500 to automatically account for oil pressure switches and similar devices that indicate a fault condition when the engine is not running. Setting ENGINE_PRTCT_RUN_TIME to 8000 or more will disable the engine protection option.

**ENGINE_PROTECT_TIME**

The amount of time spent with the engine protection input made before the actuator is shut down (msec).

The APECS 4500 has a dedicated engine protection switch input. The engine protection feature must be enabled by setting ENGINE_PRTCT_RUN_TIME to a value less than 8000. Once the engine has been in run mode longer than ENGINE_PRTCT_RUN_TIME, if the engine protection input is grounded for longer than ENGINE_PROTECT_TIME milliseconds, the governor will go into shutdown mode and the fault lamp will flash a four code.

**Calibration Procedures**

ENGINE_PRTCT_RUN_TIME is set to the time in seconds the engine must be running before a grounded signal on the engine protection input will be serviced. If ENGINE_PRTCT_RUN_TIME is set to 0, then the input will also inhibit any actuator duty
cycle at cranking if the engine protection switch contacts are closed. The input must be made before engine shutdown (actuator output) will begin.

If the engine has been running longer than ENGINE_PRTCT_RUN_TIME, and the engine protection input has been made continually (not intermittently), then the actuator will be shutdown and a fault will be generated. The lamp on the APECS unit will flash to indicate the fault, and the fault will be cleared when the engine is restarted.

**Overspeed / Underspeed Protection**

This feature incorporates user selectable overspeed and underspeed parameters that affect engine shutdown.

**Calibration Parameters Needing Configuration:**

**OVERSPEED_RPM**

Critical engine speed used for overspeed protection (rpm).

Set OVERSPEED_RPM to zero if overspeed protection is not desired. Normal closed-loop governing will decrease the duty cycle to the actuator any time engine speed is above the set point. Overspeed protection immediately shuts off the actuator when an overspeed condition is detected. Engine speed must be brought back to zero before the actuator is driven again. Setting OVERSPEED_RPM to zero disables the overspeed protection feature. Default value: 0.

**UNDERSPEED_RPM**

Minimum engine speed used for underspeed shutdown (rpm).

Normal closed-loop governing will increase the duty cycle to the actuator any time engine speed is below the set point. Underspeed shutdown immediately shuts off the actuator when an underspeed condition is detected. Engine speed must be brought back to zero before the actuator is driven again. Setting UNDERSPEED_RPM to zero disables the underspeed protection feature.

**UNDERSPEED_RUN_TIME**

Amount of time the engine must be in run mode before underspeed shut down is activated (seconds).

**Calibration Procedures**

The overspeed protection feature immediately shuts off the actuator when the engine runs above OVERSPEED_RPM. Setting the OVERSPEED_RPM value to zero disables this feature.

The underspeed protection feature immediately shuts off the actuator when the engine rpm runs under the UNDERSPEED_RPM value. Set the UNDERSPEED_RUN_TIME value as desired. Setting the UNDERSPEED_RPM value to zero disables the underspeed protection feature.

When an engine overspeed/underspeed condition is detected, the engine protection control logic causes: (1) the actuator duty cycle to go immediately to zero (2) a fault code activation which is signified by LED flashing. After engine protection control logic tripping, the fault code will continue to flash the LED. This signifies to the user that the engine stopped due to overspeed or underspeed engine conditions. The engine may later be restarted without resetting the unit; this action will cause the fault code to reset and the LED will then stop flashing.
Overspeed FAQ

How Does Overspeed Work?

The APECS 4500 has the diagnostic capability to detect and react to an overspeed condition. The feature uses two programmable parameters, OVERSPEED_RPM and OVERSPEED_TIME. Overspeed feature immediately shuts off the actuator when the engine runs above OVERSPEED_RPM for OVERSPEED_TIME.

OVERSPEED_TIME is used to adjust the sensitivity. A large value will delay the shut down, and a small value will hasten it. A value as small as zero can be used, which means that the first occurrence of engine speed being over OVERSPEED_RPM will result in a shut down. This is too sensitive and the engine could be shut down in the unlikely event that noise on the speed signal input caused a high miscalculation of engine speed. A minimum value of 250 msec is recommended. The user should realistically determine an overspeed tolerance time.

When an overspeed condition is detected, the duty cycle goes immediately to zero. This should stop the engine or at least drive it to minimum speed. A fault code is generated, and the LED flashes. The fault will continue to flash so that the user is made aware of why the engine stopped. The engine may be restarted without resetting the unit. The fault will then recover and stop flashing.

By default, overspeed is disabled. This is because a properly tuned PID governor will decrease the duty cycle to the actuator any time engine speed is above the set point. So ordinarily, overspeed is not necessary. It is disabled by setting OVERSPEED_RPM to zero. However, if a user feels the need for a more aggressive response to an overspeed condition, the overspeed diagnostic feature may be used.

Actuator Output Calibration Parameters

This section covers actuator output calibration parameter configuration.

Actuator Current Protection

The actuator current protection feature limits current to the actuator in order to protect the actuator from overheating. Current protection limits the steady-state current to the actuator, but allows higher currents for short durations. There are two types of current limiting:

1. Soft limit (can be exceeded for a brief period of time)
2. Hard limit (can never be exceeded)—provides short-circuit protection for the driver

SOFT LIMIT

Actuator current is monitored using display parameter actuator_fdbk_sense. If actuator_fdbk_sense exceeds HIGH_ACTFDBK_LMX for HIGH_ACTFDBK_TIME (in seconds), then the duty cycle maximum limit is ramped down until the current is below the limit threshold.

Once the current sense is under the threshold, the recovery period, HIGH_AFB_RECV_TIME (in seconds), maintains the reduced duty cycle limit. After the recovery period, the duty cycle limit is allowed to ramp back up to its normal level. As the duty cycle is ramping back up, and if it exceeds the upper limit, it is immediately ramped back down again. Once the duty cycle limit ramps up completely, current protection is fully recovered.
High current limiting is only active in run mode. There is no limit (except for short circuit protection) during cranking. It is assumed that the crank sequence will not be long enough to damage an actuator.

**HARD LIMIT**

There is also a higher critical threshold, `HIGH_AFB_CRITICAL`, intended to protect the controller from a short circuit on the actuator output. If `actuator_fdbk_sense` exceeds this critical threshold, then the duty cycle is immediately reduced to zero. Recovery is allowed after `OVER_CRNT_RECV_TIME` (in seconds). With zero duty cycle, it is unlikely that an engine will start or run. Critical current protection is active in all engine operating modes.

While current is being actively limited, fault 9 is flagged—limiting excessive actuator current. If the fault is due to exceeding `HIGH_AFB_CRITICAL`, which causes the duty cycle to go to zero and the engine to not start or shut down, the fault will remain active until the engine is restarted. This helps the user to determine the cause of an engine shutdown.

Actuator current is proportional to the current driver feedback sense output. Due to sensitivity to voltage at low current levels, the feedback sense value is not converted to amps, which might be regarded as inaccurate. The feedback sense value is accurate in relative terms, and is adjusted for part-to-part variability.

The current sense output from the driver chip is read by the a/d converter, and stored in variable `adc_actfb`. This value is then filtered using a first-order filter with time constant `ACT_FDBK_KFILT`. The resulting filtered value is `adc_actfb_filt`. To account for part-to-part variability, `adc_actfb_filt` is then multiplied by gain `ACTUATOR_FDBK_GAIN`, yielding `actuator_fdbk_sense`.

**Calibration Parameters Needing Configuration:**

**HIGH_ACTFDBK_DC_RAMP**

This current protection feature limits the steady-state current to the actuator, but allows higher currents for short durations.

If `actuator_fdbk_sense` exceeds `HIGH_ACTFDBK_LMX` then the duty cycle maximum limit is ramped down until the current is below the limit threshold. After the recovery period (`HIGH_AFB_RECV_TIME`) the duty cycle limit is allowed to ramp back up to its normal level. Once the duty cycle limit ramps up completely, current protection is fully recovered.

`HIGH_ACTFDBK_DC_RAMP` controls the rate at which the duty cycle is ramped up and down, specified in units of duty cycle change per 10 msec. For example, if the value is 0.01, it means that the duty cycle will change by 1% every 10 msec, or 100% in 1 sec.

**HIGH_ACTFDBK_LMX**

This current protection feature limits the steady-state current to the actuator, but allows higher currents for short durations.

If `actuator_fdbk_sense` exceeds `HIGH_ACTFDBK_LMX` for `HIGH_ACTFDBK_TIME` then the duty cycle maximum limit is ramped down until the current is below the limit threshold. After the recovery period (`HIGH_AFB_RECV_TIME`) the duty cycle limit is allowed to ramp back up to its normal level. Once the duty cycle limit ramps up completely, current protection is fully recovered.

The lamp on the APECS controller flashes (flash code 9) to indicate controller is limiting excessive actuator current.
NOTE: Current protection limits are NOT active during cranking. It is assumed that the crank sequence will not be long enough to damage an actuator.

HIGH_ACTFDBK_TIME
This current protection feature limits the steady-state current to the actuator, but allows higher currents for short durations.

If actuator_fdbk_sense exceeds HIGH_ACTFDBK_LMX for HIGH_ACTFDBK_TIME (in seconds) then the duty cycle maximum limit is ramped down until the current is below the limit threshold. After the recovery period (HIGH_AFB_RECV_TIME) the duty cycle limit is allowed to ramp back up to its normal level. Once the duty cycle limit ramps up completely, current protection is fully recovered.

The lamp on the APECS controller flashes (flash code 9) to indicate controller is limiting excessive actuator current.

NOTE: Current protection limits are NOT active during cranking. It is assumed that the crank sequence will not be long enough to damage an actuator.

HIGH_AFB_CRITICAL
If actuator_fdbk_sense exceeds HIGH_AFB_CRITICAL, the actuator duty cycle is immediately reduced to zero. Recovery is allowed after OVER_CRNT_RECV_TIME seconds. With zero duty cycle, it is unlikely that an engine will start or continue to run. Critical current protection is active in all engine operating modes.

The lamp on the APECS controller flashes (flash code 9) to indicate controller is limiting excessive actuator current.

HIGH_AFB_RECV_TIME
If actuator_fdbk_sense exceeds HIGH_ACTFDBK_LMX for HIGH_ACTFDBK_TIME (in seconds) then the duty cycle maximum limit is ramped down until the current is below the limit threshold. After the recovery period (HIGH_AFB_RECV_TIME) the duty cycle limit is allowed to ramp back up to its normal level. Once the duty cycle limit ramps up completely, current protection is fully recovered.

The lamp on the APECS controller flashes (flash code 9) to indicate controller is limiting excessive actuator current.

NOTE: Current protection limits are NOT active during cranking. It is assumed that the crank sequence will not be long enough to damage an actuator.

Calibration Procedures
Because actuator_fdbk_sense is dependent upon both supply voltage and actuator type, it may be necessary to determine the exact scaling between current and the parameter actuator_fdbk_sense. As a rough approximation: actuator_fdbk_sense = 80 × actuator current (amps).

The user can determine the exact relationship between current and actuator_fdbk_sense by placing an ammeter in series with the actuator and recording both current and actuator_fdbk_sense during cranking when duty cycle is fixed. Once the exact scaling is determined and the desired current limits are known, the actual current limits can be calculated.

For most applications, the default value for the hard limit will suffice to protect the controller. If desired, HIGH_AFB_CRITICAL may be decreased. Increasing this parameter may jeopardize the control module and is not recommended.
The values for the soft limits may be adjusted to limit current and may be dependent on the actuator type. In general, smaller actuators will need lower limits, as will 24-volt coils. The limits may be dependent upon ambient temperature—the higher the ambient temperature, the lower the limit will be since the actuator can dissipate less current. Current threshold (HIGH_ACTFDBK_LMX), time at current (HIGH_ACTFDBK_TIME), ramp rate (HIGH_ACTFDBK_DC_RAMP), and recovery time (HIGH_AFB_RECV_TIME) may all be adjusted at the discretion of the operator.

**Auxiliary Outputs**

The two auxiliary outputs are multipurpose outputs that can drive a lamp or a relay. See the sections beginning on page 16 for wiring information.

**Calibration Parameters Needing Configuration:**

**AUX_OUTPUT_RPM**
When AUXILIARY_OUTPUT_MODE = 1, APECS 4500 turns on the auxiliary output when engine rpm exceeds this speed. The auxiliary output turns back off if engine speed falls 20 rpm below AUX_OUTPUT_RPM.

**AUX_OUTPUT_2_RPM**
When AUXILIARY_OUTPUT_2_MODE = 1, APECS 4500 turns on auxiliary output #2 when engine rpm exceeds this speed. The auxiliary output turns back off if engine speed falls 20 rpm below AUX_OUTPUT_2_RPM.

**AUXILIARY_OUTPUT_MODE**
This parameter is used to let the software know how the auxiliary output of APECS 4500 is to be configured.

**AUXILIARY_OUTPUT_2_MODE**
This parameter is used to let the software know how auxiliary output #2 of APECS 4500 is to be configured.

**Calibration Procedures**

Set the AUXILIARY_OUTPUT_MODE and AUXILIARY_OUTPUT_2_MODE values to the settings below to achieve a target configuration for a certain APECS 4500/engine system setup.

<table>
<thead>
<tr>
<th>VALUE</th>
<th>AUXILIARY OUTPUT RESULT</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>No output</td>
</tr>
<tr>
<td>1</td>
<td>ON when engine speed is above AUX_OUTPUT_RPM</td>
</tr>
<tr>
<td>2</td>
<td>ON when there is an active diagnostic shutdown condition; use with auxiliary shutdown device</td>
</tr>
<tr>
<td>3</td>
<td>ON when PTO is engaged; use with PTO indicator lamp</td>
</tr>
<tr>
<td>4</td>
<td>Autocrank output, use to drive engine crank motor relay</td>
</tr>
<tr>
<td>5</td>
<td>Mimics on-board LED (ON when engine speed present, flashes faults)</td>
</tr>
<tr>
<td>6</td>
<td>Glowplug control</td>
</tr>
</tbody>
</table>

62 Woodward
Droop Governing

When governor droop is non-zero, governed speed reduces with increasing load. Droop may be desirable in certain load sharing applications (e.g., two gensets tied to the same electrical bus). When droop is set to zero, governed speed will be insensitive to load (isochronous).

Calibration Parameters Needing Configuration:

DROOP_ACTFDBK_MAX
Value of actuator_fdbk_sense when operating at maximum engine load. Used in conjunction with the droop governing feature.

DROOP_ACTFDBK_MIN
Value of actuator_fdbk_sense when operating at no engine load. Used in conjunction with the droop governing feature.

DROOP_PERCENT
Desired engine droop. Range: 0-15%. Droop is calculated as follows:

\[
\text{Droop} = \frac{\text{actuator_fdbk_sense} - \text{DROOP_ACTFDBK_MIN}}{\text{DROOP_ACTFDBK_MAX} - \text{DROOP_ACTFDBK_MIN}}
\]

Calibration Procedures

When operating in droop governing mode, the engine speed decreases (droops) as the load is increased.

Monitor actuator feedback at no load and at full load and set DROOP_ACTFDBK_MIN and DROOP_ACTFDBK_MAX to these values respectively. Set DROOP_PERCENT to desired droop up to 15%.

Load is inferred by measuring the actuator sense current output of the current driver.

Set DROOP_PERCENT to zero for isochronous governing.
Step 1
Setup the APECS Calibration Tool (ACT)

Step 2
Configure speed input

The APECS 4500 is a user configurable engine speed governor and will follow your settings and commands immediately. It is possible to enter values in the APECS module that are in excess of what the engine is capable of performing and outside of safe operating range. It is the user's responsibility to pay attention when entering data into the APECS or the ACT. Entering values outside of safe operating range can result in serious physical injury and/or damage to the equipment or application.
Step 3
Calibrate the selected features by configuring the listed parameters

Step 4
Determine how you would like to configure the speed set-point logic

- **Engine Cranking**
  - Default:
  - CRANK_DUTY_CYCLE: 95
  - CRANK_RUN_TIME: 750 RPM
  - KEY_ON_DUTY_TIME: 0

- **Autocrank control**
  - GLOW_PLUG_TIME
  - AUTOCRANK_CRANK_TIME
  - AUTOCRANK_REST_TIME
  - AUTOCRANK_MAX_TIME

- **Engine Protection Input**
  - Default:
  - ENGINE_PROTECT_RUN_TIME: 8000 (disabled)

- **Actuator Current Protection**
  - OVER_CURRENT_LMX

- **Auxiliary Output**
  - Default:
  - AUXILIARY_OUTPUT_MODE: 0
  - AUXILIARY_OUTPUT_RPM: 0

- **Auxiliary Output #2**
  - Default:
  - AUXILIARY_OUTPUT_2_MODE: 0
  - AUXILIARY_OUTPUT_2_RPM: 0

- **Droop Governing**
  - Default:
  - DROOP_CURRENT_MAX: 0
  - DROOP_CURRENT_MIN: 0
  - DROOP_PERCENT: 0

- **PTO Input**
  - EXTERNAL_ANALOG_MODE
  - SWITCH_CONFIGURATION

- **No external analog input**
  - Speed Switch
  - Momentary Switch

- **Overspeed/Underspeed Protection**
  - Default:
  - OVERSPEED_RPM
  - UNDERSPEED_RPM
  - UNDERSPEED_RUN_TIME

- **Trim Mode**
  - Use external pot to trim the selected set speed

- **Set Speed with pot**
  - Use external pot to adjust set speed. PTO is available.

- **Drive-by-wire**
  - Similar to set speed with pot but with additional fault management. Suitable for pedal applications.
  - PTO is available
  - Idle verification switch is available
Step 5
Select appropriate external analog mode

Step 6
Calibrate the required parameters to configure engine speed input

Use speed switch (EXTERNAL_ANALOG_MODE = 000)

Use momentary switch (EXTERNAL_ANALOG_MODE = 000)

Trim Mode (EXTERNAL_ANALOG_MODE = 001)

Trim Mode, reverse pot (EXTERNAL_ANALOG_MODE = 101)

Set speed with pot (EXTERNAL_ANALOG_MODE = 002)

Set speed with pot (EXTERNAL_ANALOG_MODE = 102)

Set speed with pot, PTO Available (EXTERNAL_ANALOG_MODE = 012)

Set speed with pot, PTO Available (EXTERNAL_ANALOG_MODE = 112)

Drive-by-wire, no IVS (EXTERNAL_ANALOG_MODE = 003)

Drive-by-wire, IVS normally closed (EXTERNAL_ANALOG_MODE = 103)

Drive-by-wire, IVS normally open (EXTERNAL_ANALOG_MODE = 113)

Drive-by-wire, no IVS (EXTERNAL_ANALOG_MODE = 013)

Drive-by-wire, IVS normally closed (EXTERNAL_ANALOG_MODE = 213)

Drive-by-wire, IVS normally open (EXTERNAL_ANALOG_MODE = 213)
Step 7
Calibrate any additional parameters, if needed.

Step 8
Calibrate any additional parameters, if needed.

**External Pot Calibration**

This external pot calibration needs to be calibrated for use in the desired speed mode.
The calibration process is automatic. Simply set the parameter
EXTERNAL ANALOG MODE to 255 and run
the external pot or pedal through its full range of travel. This controller will
automatically learn and store the minimum and maximum values in its memory. Set
EXTERNAL ANALOG MODE back to the
desired speed mode when finished.

**SET_SPEED_WARMUP**

**WARMUP_TIME**

**RAMP_DOWN_RATE**

**RAMP_UP_RATE**

**SPEED_DECREASE_DELAY**

(PTO only)

**PID Gains Adjustment**

DERIVATIVE_GAIN

INTEGRAL_GAIN

PROPORTIONAL_GAIN

MASTER_GAIN

PID Gains too high

Integral gain too high or derivative gain too low

PID Gains too low

Derivative gain too high

Integral gain too low

Desired response

**Woodward 67**
Chapter 5.
Troubleshooting

General Checklist

Please follow the checklist below to troubleshoot your APECS controller.

We recommend using a digital multimeter capable of measuring frequency and duty cycle such as a Fluke 87.

1. Check battery voltage for stability and correct value. The LED will turn on for one second when the APECS 4500 is first powered up.

2. For magnetic pickups, check that the speed signal is at least 2 V_{rms} using the AC volt settings on voltmeter. Actuator should go to full travel during cranking. The LED will illuminate when it senses an engine speed.

3. Check the actuator linkage for binding and backlash.

4. Check that the actuator has sufficient force to reach the starting and rated load positions.

5. Confirm normal operation of engine under manual control.

6. Confirm that the load (e.g., voltage regulator on generator) is not inducing instability.

7. Try adjusting the gains to achieve stability.

Fault Codes

The APECS 4500 controller is capable of identifying certain fault conditions and alerting the user to them. A flashing LED indicates the fault conditions. The current fault code list is shown in Table 6. Please note the following:

1. When power is first applied to the controller, the LED will flash just once for one second to indicate that the LED is working.

2. If there are multiple faults, the LED will flash them all in sequence. Count the flash codes to determine the fault conditions or connect the Calibration Tool to observe the fault conditions. (Use the “Display Faults” option under the Monitor Menu.)

3. If there are no faults, the LED will flash once at reset and from then on indicate the detection of engine speed. A continuous ON LED indicates that a valid engine speed is being sensed.

4. The controller will attempt to shut down for some faults and will not permit starting after reset with faults 1, 5 and 8.
## Table 6. Fault Codes

<table>
<thead>
<tr>
<th>FLASH CODE</th>
<th>FAULT</th>
<th>ENGINE SHUTDOWN</th>
<th>CORRECTIVE ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>APECS unit not calibrated</td>
<td>Yes</td>
<td>Calibrate APECS unit.</td>
</tr>
<tr>
<td>2</td>
<td>Engine speed excessive</td>
<td>Yes</td>
<td>Check parameter settings. Overspeed criteria may be too sensitive. Check for electrical noise entering controller. Check wiring and connections. Check case ground. Make sure linkage moves freely, without backlash. Check tip of speed sensor.</td>
</tr>
<tr>
<td>3</td>
<td>Engine speed unusually low</td>
<td>Yes</td>
<td>Check parameter settings. Check linkage and the actuator travel. Ensure that load is not greater than engine capacity.</td>
</tr>
<tr>
<td>4</td>
<td>Engine shutdown due to engine protection input</td>
<td>Yes</td>
<td>Check parameter settings. Check what may have triggered the protection input.</td>
</tr>
<tr>
<td>5</td>
<td>Factory settings lost</td>
<td>Yes</td>
<td>If calibration file is available, download calibration file and cycle power again. If controller still does not work or if no calibration file is available, consult factory.</td>
</tr>
<tr>
<td>6</td>
<td>External pot out-of-range</td>
<td>No</td>
<td>Verify that pot is wired correctly. Recalibrate external pot.</td>
</tr>
<tr>
<td>7</td>
<td>Accelerator position / idle switch conflict</td>
<td>No</td>
<td>Verify that signals are working and synchronized.</td>
</tr>
<tr>
<td>8</td>
<td>Controller unit failed</td>
<td>Yes</td>
<td>Electrical noise may be entering controller. Check wiring, shielding and connections to controller. Cycle power to engine. If controller still does not work, consult factory.</td>
</tr>
<tr>
<td>9</td>
<td>Limiting excessive actuator current</td>
<td>No</td>
<td>Check actuator for short to ground or low resistance. Check parameter settings. Check linkage and actuator travel. Ensure that load is not greater than engine capacity.</td>
</tr>
<tr>
<td>10</td>
<td>Engine speed input signal missing</td>
<td>No</td>
<td>(Active only in Autocrank mode) Check speed sensor wiring. Check starter motor.</td>
</tr>
<tr>
<td>11</td>
<td>Autocrank unable to start engine</td>
<td>No</td>
<td>Check fuel.</td>
</tr>
<tr>
<td>12</td>
<td>Auxiliary output is shorted</td>
<td>No</td>
<td>Check the lamp or relay hooked to the output. If fault is still present, consult factory.</td>
</tr>
<tr>
<td>13</td>
<td>Auxiliary output #2 is shorted</td>
<td>No</td>
<td>Check the lamp or relay hooked to the output. If fault is still present, consult factory.</td>
</tr>
<tr>
<td>14</td>
<td>Actuator disconnected or open circuit</td>
<td>No</td>
<td>Check actuator wiring and actuator resistance. Resistance should be less than 10 ohms.</td>
</tr>
</tbody>
</table>
**Glossary of Technical Terms**

**ACT (All-purpose Calibration Tool) Software**
PC software program for configuring and calibrating the APECS controller

**Actuator**
Device that converts an electrical signal from the APECS controller to an output shaft position

**APECS (Advanced Proportional Engine Control System)**
Engine governing system developed by Woodward

**APP**
Analog Pedal Position. An analog input with voltage proportional to the desired engine speed

**Autocrank**
An APECS feature that allows remote or automatic starting of the engine using one of the auxiliary outputs

**Cal File**
File containing APECS calibration data

**Cal Tool Version**
The version of calibration tool software in use

**Calibration**
Process of configuring and adjusting the controller to work with a specific application

**Calibration Wizard**
Interactive software guide to help you set up basic calibration and get the controller in operation quickly

**Control Strategy**
The version of software residing in the controller

**Duty Cycle**
Percentage of time a pulse width modulated (PWM) signal remains on

**Glowplugs**
Electric heating elements used to enhance cold starting of diesel engines. The auxiliary outputs can be configured to control glowplugs through a relay

**Parameter**
Numerical value that helps the user calibrate the APECS controller

**PTO**
Power Take-off. An APECS feature that allows selection between pedal input and speed switch

**PWM (Pulse Width Modulation)**
Means of simulating analog output with a digital device. The PWM duty cycle determines the equivalent analog output: the higher the duty cycle, the higher the equivalent analog output.

**Speed Sensor**
Device such as a magnetic pickup that senses engine speed
Chapter 6.
Service Options

Product Service Options

The following factory options are available for servicing Woodward equipment, based on the standard Woodward Product and Service Warranty (5-01-1205) that is in effect at the time the product is purchased from Woodward or the service is performed:

- Replacement/Exchange (24-hour service)
- Flat Rate Repair
- Flat Rate Remanufacture

If you are experiencing problems with installation or unsatisfactory performance of an installed system, the following options are available:

- Consult the troubleshooting guide in the manual.
- Contact Woodward technical assistance (see “How to Contact Woodward” later in this chapter) and discuss your problem. In most cases, your problem can be resolved over the phone. If not, you can select which course of action you wish to pursue based on the available services listed in this section.

Replacement/Exchange

Replacement/Exchange is a premium program designed for the user who is in need of immediate service. It allows you to request and receive a like-new replacement unit in minimum time (usually within 24 hours of the request), providing a suitable unit is available at the time of the request, thereby minimizing costly downtime. This is also a flat rate structured program and includes the full standard Woodward product warranty (Woodward Product and Service Warranty 5-01-1205).

This option allows you to call in the event of an unexpected outage, or in advance of a scheduled outage, to request a replacement control unit. If the unit is available at the time of the call, it can usually be shipped out within 24 hours. You replace your field control unit with the like-new replacement and return the field unit to the Woodward facility as explained below (see “Returning Equipment for Repair” later in this chapter).

Charges for the Replacement/Exchange service are based on a flat rate plus shipping expenses. You are invoiced the flat rate replacement/exchange charge plus a core charge at the time the replacement unit is shipped. If the core (field unit) is returned to Woodward within 60 days, Woodward will issue a credit for the core charge. [The core charge is the average difference between the flat rate replacement/exchange charge and the current list price of a new unit.]

Return Shipment Authorization Label. To ensure prompt receipt of the core, and avoid additional charges, the package must be properly marked. A return authorization label is included with every Replacement/Exchange unit that leaves Woodward. The core should be repackaged and the return authorization label affixed to the outside of the package. Without the authorization label, receipt of the returned core could be delayed and cause additional charges to be applied.
Flat Rate Repair

Flat Rate Repair is available for the majority of standard products in the field. This program offers you repair service for your products with the advantage of knowing in advance what the cost will be. All repair work carries the standard Woodward service warranty (Woodward Product and Service Warranty 5-01-1205) on replaced parts and labor.

Flat Rate Remanufacture

Flat Rate Remanufacture is very similar to the Flat Rate Repair option with the exception that the unit will be returned to you in “like-new” condition and carry with it the full standard Woodward product warranty (Woodward Product and Service Warranty 5-01-1205). This option is applicable to mechanical products only.

Returning Equipment for Repair

If a control (or any part of an electronic control) is to be returned to Woodward for repair, please contact Woodward in advance to obtain a Return Authorization Number. When shipping the item(s), attach a tag with the following information:

- name and location where the control is installed;
- name and phone number of contact person;
- complete Woodward part number(s) and serial number(s);
- description of the problem;
- instructions describing the desired type of repair.

CAUTION

To prevent damage to electronic components caused by improper handling, read and observe the precautions in Woodward manual 82715, Guide for Handling and Protection of Electronic Controls, Printed Circuit Boards, and Modules.

Packing a Control

Use the following materials when returning a complete control:

- protective caps on any connectors;
- antistatic protective bags on all electronic modules;
- packing materials that will not damage the surface of the unit;
- at least 100 mm (4 inches) of tightly packed, industry-approved packing material;
- a packing carton with double walls;
- a strong tape around the outside of the carton for increased strength.
Return Authorization Number

When returning equipment to Woodward, please telephone and ask for the Customer Service Department [1 (800) 523-2831 in North America or +1 (970) 482-5811]. They will help expedite the processing of your order through our distributors or local service facility. To expedite the repair process, contact Woodward in advance to obtain a Return Authorization Number, and arrange for issue of a purchase order for the item(s) to be repaired. No work can be started until a purchase order is received.

NOTE
We highly recommend that you make arrangement in advance for return shipments. Contact a Woodward customer service representative at 1 (800) 523-2831 in North America or +1 (970) 482-5811 for instructions and for a Return Authorization Number.

Replacement Parts

When ordering replacement parts for controls, include the following information:
• the part number(s) (XXXX-XXXX) that is on the enclosure nameplate;
• the unit serial number, which is also on the nameplate.

How to Contact Woodward

In North America use the following address when shipping or corresponding:
Woodward Governor Company
PO Box 1519
1000 East Drake Rd
Fort Collins CO 80522-1519, USA

Telephone: +1 (970) 482-5811 (24 hours a day)
Toll-free Phone (in North America): 1 (800) 523-2831
Fax: +1 (970) 498-3058

For assistance outside North America, call one of the following international Woodward facilities to obtain the address and phone number of the facility nearest your location where you will be able to get information and service.

<table>
<thead>
<tr>
<th>Facility</th>
<th>Phone Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brazil</td>
<td>+55 (19) 3708 4800</td>
</tr>
<tr>
<td>India</td>
<td>+91 (129) 230 7111</td>
</tr>
<tr>
<td>Japan</td>
<td>+81 (476) 93-4661</td>
</tr>
<tr>
<td>The Netherlands</td>
<td>+31 (23) 5661111</td>
</tr>
</tbody>
</table>

You can also contact the Woodward Customer Service Department or consult our worldwide directory on Woodward’s website (www.woodward.com) for the name of your nearest Woodward distributor or service facility. [For worldwide directory information, go to www.woodward.com/ic LOCATIONS.]
Engineering Services

Woodward Industrial Controls Engineering Services offers the following after-sales support for Woodward products. For these services, you can contact us by telephone, by email, or through the Woodward website.

- Technical Support
- Product Training
- Field Service

Contact information:
  Telephone: +1 (847) 967-7730
  Fax: +1 (847) 967-7832
  E-mail: info_niles@woodward.com
  Website—www.woodward.com/ic

**Technical Support** is available through our many worldwide locations or our authorized distributors, depending upon the product. This service can assist you with technical questions or problem solving during normal business hours. Emergency assistance is also available during non-business hours by phoning our toll-free number and stating the urgency of your problem. For technical support, please contact us via telephone, email us, or use our website and reference **Customer Services and then Technical Support**.

**Product Training** is available at many of our worldwide locations (standard classes). We also offer customized classes, which can be tailored to your needs and can be held at one of our locations or at your site. This training, conducted by experienced personnel, will assure that you will be able to maintain system reliability and availability. For information concerning training, please contact us via telephone, email us, or use our website and reference **Customer Services and then Product Training**.

**Field Service** engineering on-site support is available, depending on the product and location, from one of our many worldwide locations or from one of our authorized distributors. The field engineers are experienced both on Woodward products as well as on much of the non-Woodward equipment with which our products interface. For field service engineering assistance, please contact us via telephone, email us, or use our website and reference **Customer Services and then Technical Support**.
If you need to telephone for technical assistance, you will need to provide the following information. Please write it down here before phoning:

General
Your Name__________________________________________________________
Site Location________________________________________________________
Phone Number________________________________________________________
Fax Number___________________________________________________________

Prime Mover Information
Engine/Turbine Model Number___________________________________________
Manufacturer___________________________________________________________
Number of Cylinders (if applicable)_______________________________________
Type of Fuel (gas, gaseous, steam, etc)____________________________________
Rating_______________________________________________________________
Application___________________________________________________________

Control/Governor Information
Please list all Woodward governors, actuators, and electronic controls in your system:

Woodward Part Number and Revision Letter

Control Description or Governor Type

Serial Number

Woodward Part Number and Revision Letter

Control Description or Governor Type

Serial Number

Woodward Part Number and Revision Letter

Control Description or Governor Type

Serial Number

If you have an electronic or programmable control, please have the adjustment setting positions or the menu settings written down and with you at the time of the call.